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Product description

The Applied Biosystems™ ViralSEQ™ Lentivirus Titer Kits are TagMan™-based, real-time PCR assays
for process development and characterization of lentivirus vectors. The ViralSEQ™ Lentivirus Physical
Titer Kit quantitates the amount of lentivirus in the supernatants of cell-based, bioproduction systems.
The ViralSEQ™ Lentivirus Proviral DNA Titer Kit quantitates genome copies integrated into cells post-
transduction. Both kits use provided controls to generate standard curves used in quantitation. With
specific quantitation of viral and proviral copy numbers, gPCR data from physical and infectious titers
can be easily compared. Together, the ViralSEQ™ Lentivirus Titer Kits provide a convenient method to
correlate total and infectious lentiviral particles during process development and optimization.

Both the ViralSEQ™ Lentivirus Physical Titer Kit and the ViralSEQ™ Lentivirus Proviral DNA Titer Kit

are compatible with the PrepSEQ™ Nucleic Acid Sample Preparation Kit (Cat. A50485), which offers
both manual and automated sample preparation workflows. For real-time PCR, both kits have been
validated on the Applied Biosystems™ 7500 Fast Real-Time PCR System and the Applied Biosystems™
QuantStudio™ 5 Real-Time PCR System. Data analysis is streamlined using AccuSEQ™ Real-Time
PCR Software that provides accurate quantitation. The software has security, audit, and e-signature
capabilities to enable 21 CFR Pt 11 compliance.

* The ViralSEQ™ Lentivirus Physical Titer Kit can be used to quantitate viral titers through the
measurement of lentivirus RNA in the supernatants of cell-based production systems.

* The ViralSEQ™ Lentivirus Proviral DNA Titer Kit is used to quantitate the number of proviral copies
incorporated into host cells following transduction.
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Contents and storage

Contents and storage

ViralSEQ™ Lentivirus Titer Kits

Table 1 ViralSEQ™ Lentivirus Physical Titer Kit (Cat. No. A52597)

Contents Cap color Amount Storage

Box 1, ViralSEQ™ Lentivirus Physical Titer gPCR Reagents

Physical Titer Assay Mix Protect from light.

275 L
(G0|d) -25°C to -15°C
25X RT-PCR Enzyme Mix Q
110 pL
(Green)
-30°C to -10°C
2X RT-PCR Buffer ‘
1.375 mL
(Red)
Nuclease Free Water Q —25°C to —15°C until first use. After
1.0mlL first use, store at 2-8°C
(White) ’ '

Box 2, ViralSEQ™ Lentivirus Physical Titer RNA Control

Physical Titer RNA Control (2 .
X 1010 copies/pL) 44 L

(Gray) -25°C to -15°C
RNA Dilution Buffer Clear bottle 7.0 mL

Table 2 ViralSEQ™ Lentivirus Physical Titer Kit with PrepSEQ™ Nucleic Acid Sample Preparation Kit
(Cat. No. A52598)

Contents Cat. No. Amount
ViralSEQ™ Lentivirus Physical Titer Kit A52597 1 kit
PrepSEQ™ Nucleic Acid Sample Preparation Kit A50485 1 kit
DNase |, RNase-free (1 U/pL) ENO0531 1 kit

ViralSEQ™ Lentivirus Titer Kits User Guide



https://www.thermofisher.com/search/results?query=A52597&focusarea=Search%20All&scope=PDF
https://www.thermofisher.com/search/results?query=A52598&focusarea=Search%20All&scope=PDF
https://www.thermofisher.com/search/results?query=A52597&focusarea=Search%20All&scope=PDF
https://www.thermofisher.com/search/results?query=A50485&focusarea=Search%20All&scope=PDF
https://www.thermofisher.com/search/results?query=EN0531&focusarea=Search%20All&scope=PDF

Chapter 1 Product information [0
Contents and storage

Table 3 ViralSEQ™ Lentivirus Proviral DNA Titer Kit (Cat. No. A53561)

Contents Cap color Amount Storage
Box 1, ViralSEQ™ Lentivirus Proviral DNA Titer gPCR Reagents
Proviral DNA Titer Assay Mix Protect from light.
660 pL
(Purple) -25°C to -15°C
2X Environmental Master Mix
2.0 2 X0.75 mL -25°C to -15°C
(Orange)
Nucl Free Wat
uciease rree tvater Q —25°C to —15°C until first use. After
1.0 mlL first use, store at 2-8°C
(White) ’ ’
Box 2, ViralSEQ™ Lentivirus Proviral DNA Titer Control
Proviral DNA Titer Control -25°C to -15°C
(2X108 copies/pL)
(Blue) 44 L IMPORTANT! Do not store below
-25°C.
DNA Dilution Buffer Clear bottle 7.0mL —25°C to -15°C

Table 4 ViralSEQ™ Lentivirus Proviral DNA Titer Kit with PrepSEQ™ Nucleic Acid Sample Preparation

Kit (Cat. No. A53562)

Contents Cat. No. Amount
ViralSEQ™ Lentivirus Proviral DNA Titer Kit A53561 1 kit
PrepSEQ™ Nucleic Acid Sample Preparation Kit A50485 1 kit

PrepSEQ™ Nucleic Acid Sample Preparation Kit (included with Cat. Nos. A52598

and A53562)
Table 5 PrepSEQ™ Nucleic Acid Sample Preparation Kit

Contents Amount Storage
Box 1, PrepSEQ™ Nucleic Acid Extraction Kit
Lysis Buffer 2 x50 mL
Binding Solution (Isopropanol), empty bottle 1
Wash Buffer Concentrate 2 x 26 mL
Room temperature

Elution Buffer 25 mL
Proteinase K (PK) Buffer

50 mL
Can be used for existing validated manual protocols.
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Table 5 PrepSEQ Nucleic Acid Sample Preparation Kit (continued)

Contents Amount Storage

Proteinase K (PK) Buffer II"]
Recommended for new manual protocols. 11 mL Room temperature

Required for automated protocols.

Box 2, PrepSEQ™ Nucleic Acid Extraction Kit

Magnetic Particles 2x1.5mL Room temperature

Box 3, PrepSEQ™ Nucleic Acid Extraction Kit

Proteinase K, 20 mg/mL 1.25 mL —20°C or below

PrepSEQ™ Residual DNA Sample Preparation Kit

Proteinase K, 20 mg/mL 1.25 mL
Yeast tRNA, 10 mg/mL 0.5mL —20°C or below
Glycogen, 5 mg/mL 2x1.0mL

' Also sold separately (Cat. No. 4415320).

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Catalog numbers that appear as links open the web pages for those products.

Required for the ViralSEQ™ Lentivirus Titer Kits

Item Source

Real-time PCR Instrument and software

QuantStudio™ 5 Real-Time PCR System with AccuSEQ™ software Contact your local sales
v3.1 or later representative.
Equipment

(If using automated sample preparation) KingFisher™ Flex Purification 5400630

System with 96 Deep-Well Head

Microcentrifuge MLS
Laboratory mixer, vortex, or equivalent MLS
Plate centrifuge MLS
VeritiPro™ 96-well Thermal Cycler A48141
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(continued)
Iltem Source
Consumables
Disposable gloves MLS
Aerosol-resistant pipette tips MLS
Nuclease-free microcentrifuge tubes MLS
Pipettors: MLS
* Positive-displacement
* Air-displacement
* Multichannel
MicroAmp™ Optical 96-Well Reaction Plate, 0.2 mL 4316813

Consumables for the QuantStudio™ 5 Real-Time PCR System

MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode, 0.1 4346906
mL

MicroAmp™ 96-Well Tray/Retainer Set 403081
MicroAmp™ Optical Adhesive Film 4360954
MicroAmp™ 96-Well Base N8010531
MicroAmp™ Adhesive Film Applicator 4333183

Recommended for sample extraction

PrepSEQ™ Nucleic Acid Sample Preparation Kitl'! A50485

5 M NaCl MLS

Recommended for DNase treatment (ViralSEQ™ Lentivirus Physical Titer Kit only)

DNase |, RNase-free (1 U/uL)@ EN0531

50 mM EDTA MLS

' Included with Cat. Nos. A52598 and A53562.
[ |ncluded with Cat. No. A52598.
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Required for manual sample preparation

ltem Source

Equipment
Magnetic stand, 16-position 12321D
Block heater for use with 2-mL tubes. MLS
Manual DNA/RNA extraction involves two incubations at different settings, so two
heaters may be convenient.
Benchtop microcentrifuge for 1.5-mL and 2-mL tubes MLS
Vortex MLS
Vortex Adapter-60, for use with the Vortex-Genie™ AM10014
Consumables
Disposable gloves MLS
Aerosol-resistant micropipette tips MLS
Pipettors, P1000, P200, P20 and P10: MLS

* Positive-displacement

* Air-displacement

* Multichannel
Nonstick, RNase-free Microfuge Tubes, 1.5-mL (1 box; 250 tubes/box) AM12450

Safe-Lock Tube, 2.0-mL

VWR™ 62111-754

Reagents

Ethanol, 95% MLS
IMPORTANT! Do not use denatured ethanol. It contains components that are not

compatible with the protocol.

Isopropanol, 100% MLS
1X PBS (free of Mg and Ca) MLS
0.5 M NaCl MLS
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Required for automated sample preparation

Table 6 Pharma KingFisher™ Flex Purification System with 96 Deep-Well Head (Cat. No. A31508)

accessories
Iltem Source
Pharma KingFisher™ Flex 96 Deep-Well Tip Combs A43074
Pharma KingFisher™ Flex 96 Deep-Well Plates A43075
Pharma KingFisher™ Flex Magnetic Head for 96 Deep-Well Plate A31542
Pharma MagMAX™ 96 PCR Well Magnetic Head 4472991
Pharma KingFisher™ Flex 96 Standard Plate A43076
(Optional) Pharma Magnetic Stand-96 A31543
Table 7 Additional materials
Iltem Source
Consumables
Disposable gloves MLS
Aerosol-resistant micropipette tips MLS
Pipettors, P1000, P200, P20 and P10: MLS
* Positive-displacement
* Air-displacement
* Multichannel
Nonstick, RNase-free Microfuge Tubes, 1.5-mL (1 box; 250 tubes/box) AM12450
Reagents
Ethanol, 95% MLS
IMPORTANT! Do not use denatured ethanol. It contains components that are not compatible
with the protocol.
Isopropanol, 100% MLS
1X PBS (free of Mg and Ca) MLS
0.5 M NaCl MLS
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Lentivirus production

The ViralSEQ™ Lentivirus Physical Titer Kit is used to quantitate viral particles produced using cell-
based systems. We recommend using the LV-MAX™ Lentiviral Production System (Cat. No. A35684) to
produce high titer lentiviral vectors. The system is based on the transient transfection of high-density,
suspension HEK293F cells adapted to a chemically defined, serum-free and protein free medium. For
more information, see the LV-MAX™ Lentiviral Production System User Guide (Pub. No. MAN0O17000).

Kit controls

Table 8 ViralSEQ™ Lentivirus Physical Titer Kit

Control Use

Internal Positive Control (IPC) Lack of amplification Indicates PCR inhibition.

(Included in the Physical Titer Assay Mix)

Physical Titer RNA Control (2 X100 copies/uL) Ampilification indicates that the PCR was successful.

Negative control (RNA Dilution Buffer) Amplification indicates contamination.

Table 9 ViralSEQ™ Lentivirus Proviral DNA Titer Kit

Control Use

Internal Positive Control (IPC) Lack of amplification Indicates PCR inhibition.

(Included in the Proviral DNA Titer Assay Mix)

Proviral DNA Titer Control (2 X 108 copies/uL) Amplification indicates that the PCR was successful.

Negative control (DNA Dilution Buffer) Amplification indicates contamination.
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A

Workflow: ViralSEQ™ Lentivirus Physical Titer Kit

ViralSEQ™ Lentivirus Physical Titer Kit Workflow

Produce lentivirus with the
LV-MAX™ Lentiviral Production
System

Prepare reagents and serial
dilutions

Sample extraction with the
PrepSEQ™ Nucleic Acid Sample
Preparation Kit

@ Treat samples with DNase |,
RNase-free (1 U/pL)

Prepare the PCR reactions

Start the run (QuantStudio™ 5
Real-Time PCR Instrument) AccuSEQ

Real-Time PCR Software

Version 3.2

Review the results
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Workflow: ViralSEQ™ Lentivirus Proviral DNA Titer Kit

ViralSEQ™ Lentivirus Proviral DNA Titer Kit Workflow

Lentivirus transduction of target
cells

Prepare reagents and serial
dilutions

Sample extraction with the
@ PrepSEQ™ Nucleic Acid Sample
e Preparation Kit

Prepare the PCR reactions

Start the run (QuantStudio™ 5
Real-Time PCR Instrument) AccuSEQ

Real-Time PCR Software

Version 3.2

Review the results
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We recommend using the PrepSEQ™ Nucleic Acid Sample Preparation Kit (Cat. No. A50485) for sample
preparation. The kit uses chemical lysis and magnetic beads to extract nucleic acid from recombinant
lentiviruses and integrated proviruses.

Prepare the PrepSEQ™ reagents: before first use of the kit

Magnetic beads
1. Set a block heater to 37°C.

2. Incubate the Magnetic Particle suspension at 37°C for a minimum of 10 minutes with intermittent
vortexing at 900 rpm, or until the particles are completely suspended.

Binding Solution
1. Add 45 mL of 100% isopropanol to the Binding Solution bottle.

2. Label the bottle to indicate that it contains isopropanol, then store the bottle at room temperature.

Wash Buffer Concentrate

1. Add 74 mL of 95% ethanol to one bottle of PrepSEQ™ Wash Buffer Concentrate, then mix
completely.

2. Label the bottle to indicate that it contains ethanol, then store the bottle at room temperature.
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Prepare PrepSEQ™ reagents: before each use of the kit

Proteinase K (PK) mix

* Use Proteinase K (PK) Buffer Il for all protocols.

Note: Proteinase K (PK) Buffer is provided in the kit for use by laboratories that had previously
validated with this buffer. If required, use exactly as described for Proteinase K (PK) Buffer II.

* Prepare a fresh mix before each use of the kit.

* Include a 10% overage to account for pipetting losses.

Number of extractions

Component
1 7 10 13 25
Proteinase K, 20 mg/mL 10 yL 70 pL 100 pL 130 pL 250 yL
Proteinase K (PK) Buffer Il 60 pL 420 pL 600 pL 780 pL 1,500 pL

Lysis solution

* Prepare a fresh mixture immediately before use or during Proteinase K incubation.

* Prepare 360 pL (@amount required) of lysis solution mix per sample.

Reagent Volume for 1 extraction Volume for ~20 extractions
Glycogen, 5 mg/mL 8.32 L 180 pL
Yeast tRNA, 10 mg/mL 0.18 pL 4 L
Lysis Buffer 351.5 uL 7,600 pL
Total 360 pL 7,784 pL

18
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Guidelines for optimal yields

* Maintain a homogenous suspension of the magnetic beads to maximize the surface area to which
the DNA/RNA can bind. The appearance of the mixture should be homogenous after mixing.

¢ After drying, the DNA/RNA remains bound to the magnetic beads. Do not allow the magnetic
beads to over-dry because this reduces the elution efficiency; over-dried beads are not easily
resuspended.

* During manual elution, vortex every 2 minutes to assist elution. This will result in better yield during
recovery.

Note: Some test samples cause the beads to adhere very firmly to the tube wall, while others form
loose pellets that detach during the vortex steps. All pellets should dissolve with vortexing during
heated elution. If vortexing does not result in full resuspension, then wash the beads off the tube by

pipetting.

Note: White or brown precipitate may form in the Magnetic Particles tube if it is stored at 2-8°C.
The precipitate will dissolve when it is heated to 37°C for a minimum of 10 minutes with intermittent
vortexing. Make sure the precipitate is completely dissolved before using the beads.

Serial dilutions and sample preparation for the ViralSEQ™
Lentivirus Physical Titer Kit

Collect lentivirus particles for RNA extraction and sample preparation. For test samples that contain
levels of RNA above the highest point of the assay standard curve (10° copies per reaction), dilute these
samples (from 1:100 up to 1:10,000) with a solution of 1 X PBS (free of Mg and Ca) or 50 mM Tris, pH
8.0, 0.5 M NaCl.

Note: Use sample dilution buffer as the negative extraction control or dilute extracted RNA with elution
buffer before running the PCR reaction. Diluting samples in water or TE reduces extraction efficiency.

Prepare the Lentivirus RNA control serial dilutions

Guidelines for standard dilutions

* Prepare the standard curve and the test samples in different areas of the lab.

* Use different sets of pipettors for test sample preparation and for standard curve preparation and
aliquoting to avoid cross-contamination of test samples.
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Prepare the serial dilutions

Thaw the Physical Titer RNA Control (2 X10'0 copies/pL) on ice. Vortex at medium speed for 5
seconds, briefly centrifuge, then place on ice until use.

1. Label nonstick 1.5-mL microfuge tubes: NTC, SD1, SD2, SD3, SD4, SD5, and SD6 [used for limit
of detection (LOD)].

2. Add 35 pL of RNA Dilution Buffer (RDB) to the NTC (no template control) tube. Place the tube on

Ice.

3. Perform the serial dilutions.

When dispensing RNA, pipette up and down gently. After each transfer, vortex for 7 seconds, then
centrifuge briefly.

Table 10 Standard curve dilutions (ViralSEQ™ Lentivirus Physical Titer Kit)

S ‘ﬂ‘:}:" =2 Dilution Dilution factor C°piez/f Zﬂ;ﬁaﬁﬂf\? e
SD1 5 uL RNA control + 495 uL RDB 100 1.00E+09
SD2 5 UL SD1 + 495 pL RDB 100 1.00E+07
SD3 5 UL SD2 + 495 L RDB 100 1.00E+05
SD4 5 L SD3 + 495 pL RDB 100 1,000
SD5 10 uL SD4 + 190 L RDB 20 50
SD6 (LOD) 40 pL SD5 + 160 pL RDB 5 10

Store the standard curve dilution tubes at 4°C or on ice. Use the dilutions within 6 hours for RT-qPCR.

Extraction control

guidelines

We recommend that you use the following extraction controls:

Type of control Contains Number to run Used to
Negative (NEG)!'! 1X PBS (free of Mg | 1 per batch of To monitor for contamination of the
and Ca) extractions extraction reagents.

Extraction/recovery (ERC)

Positive control from
the kit

3 per sample

* Evaluate the efficiency of DNA
or RNA extraction, recovery, and
quantification from test samples.

* Verify reagent and system
performance.

' Optional during routine testing.

20
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Table 11 Starting volumes for sample extraction

Chapter 2 Prepare reagents and serial dilutions 508
Serial dilutions and sample preparation for the ViralSEQ™ Lentivirus Physical Titer Kit

o)l

Sample type Sample (uL) SD1 (L) 1 x PBS (L) Total (uL)
Sample 5 0 95 100
Sample ERC 5 5 90 100
NEG 0 0 100 100

Note: To calculate the efficiency of nucleic acid recovery and quantification from the test
samples,subtract the amount of nucleic acid measured in the sample without the addition of DNA
or RNA control from the amount of nucleic acid measured in the ERC sample.

Spike recovery calculations

For spiked samples the percent spike recovery can be calculated from the mean quantity of replicates
and the input spike quantity:

Mean quantity of replicates

Input spike quantity x 100

Spike Recovery % =
Percent spike recovery can also be calculated with respect to spiked test replicates from the mean
quantity of spiked replicates, the mean quantity of non-spiked replicates, and the input spike quantity:

(Spiked mean quantity - non-spiked mean quantity)
Input spike quantity

Spike Recovery % = x 100

The total DNA in the test samples can be calculated using the percent spike recovery with respect to
spiked test replicates and the mean quantity of non-spiked replicates:

Non-spiked mean quantity

DNA in test sample = Spike recovery

Prepare the extraction/ recovery control (ERC) for the ViralSEQ™ Lentivirus
Physical Titer Kit

We recommend spiking the positive control RNA into the test sample so that the total control RNA
amount is 2- 10 times the amount of RNA measured in the test sample.

1. Add the appropriate control RNA dilution amount to the test sample.
2. Add PBS to a total volume of 100 uL.
3. Perform the sample extraction.

For example, if the test sample contains 1 x 108 copies in 5 pL:

1. Add 5 pL of SD1 (1 x 109) to 5 pL of the test sample.
2. Add 90 pL of PBS (final volume of 100 pL).

3. Perform sample preparation with the PrepSEQ™ Nucleic Acid Sample Preparation Kit (on the
100 pL final volume). Elute volume is 200 pL.

4. Perform the DNase treatment and gPCR.

Note: When calculating the total sample dilution factor, account for the 1:2 dilution from DNase
pre-treatment step .

ViralSEQ™ Lentivirus Titer Kits User Guide 21



2% Chapter 2 Prepare reagents and serial dilutions
Serial dilutions and sample preparation for the ViralSEQ™ Lentivirus Proviral DNA Titer Kit

The sample dilution is 1:80, so the expected copy number following gPCR is ~1.25 x 107.

Triplicate extractions

Triplicate extractions are required for post-PCR analysis calculation of mean quantity, standard
deviation, and coefficient of variation.

In addition to test samples, we recommend triplicate extractions for the negative control and the
extraction/recovery control (ERC).

Perform a single PCR reaction for each extraction.

The table below illustrates the total number of extractions required based on the 1, 2, and 3 samples
extracted in a batch.

Table 12 Total number of extractions per batch of test samples

Number of test samples Total number of extractions for the batch

1 | 3 extractions required for each: 9

? * Test sample 15
¢ Test sample extraction/recovery control (ERC)

3| * Negative extraction controll'l 21

' Optional during routine testing.

Serial dilutions and sample preparation for the ViralSEQ™
Lentivirus Proviral DNA Titer Kit

Count and transduce host cells with the lentiviral vector. The number of cells seeded for transduction
(day 1) is used to calculate infectious titer of the vector.

Harvest cells when ready. Quantitate the number of cells extracted either by the counting them or

by using the nucleic acid quantity equivalence (1 cell = 6.6 pg for diploid cells). For cells that are
non-diploid, establish the appropriate nucleic acid quantity equivalence. The number of cells extracted
is used to calculate vector copy number.

Extract DNA and prepare samples for provirus quantitation. For test samples that are suspected to
contain levels of proviral DNA above the highest point of the assay standard curve (107 copies per
reaction), dilute these samples (from 1:100 up to 1:10,000) with a solution of 1 X PBS (free of Mg and
Ca) or 50 mM Tris, pH 8.0, 0.5 M NaCl.

Note: Use sample dilution buffer as the negative extraction control or dilute extracted RNA with elution
buffer before running the PCR reaction. Diluting samples in water or TE reduces extraction efficiency.
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Serial dilutions and sample preparation for the ViralSEQ™ Lentivirus Proviral DNA Titer Kit

Prepare the Lentivirus DNA control serial dilutions

Guidelines for standard dilutions

Prepare the standard curve and the test samples in different areas of the lab.

Use different sets of pipettors for test sample preparation and for standard curve preparation and
aliquoting to avoid cross-contamination of test samples.

Prepare the serial dilutions

1.

Thaw the Proviral DNA Titer Control (2 X 108 copies/uL) and the DNA Dilution Buffer (DDB) at
room temperature for 30 - 60 minutes. Confirm that the Proviral DNA Titer Control and DDB are
completely thawed before proceeding.

Vortex the Proviral DNA Titer Control at high speed for 20-60 seconds, then centrifuge for 3-
5 seconds.

Note: When vortexing, ensure the Proviral DNA Titer Control is moving in a circular motion in the
tube. Complete thawing and resuspension is required in order to fully homogenize the Proviral DNA
Titer Control.

Label nonstick 1.5-mL microfuge tubes: NTC, SD1, SD2, SD2.1, SD3, SD4, SD5, and SD6 [used
for limit of detection (LOD)].

Add 35 pL of DNA Dilution Buffer (DDB) to the NTC (no template control) tube. Place the tube on
ice.

Perform the serial dilutions.

When dispensing DNA, pipette up and down gently. After each transfer, vortex for 7 seconds, then
centrifuge briefly.

Table 13 Standard curve dilutions (ViralISEQ™ Lentivirus Proviral DNA Titer Kit)

Copies/ PCR reaction

Serial dilution (SD) tube Dilution' Dilution factor (5 yiL of diluted DNA)
SD 1 5 pL DNA control + 495 uL DDB 100 1.00E+07

SD 2 5 uL SD1 + 495 uL DDB 100 1.00E+05
SD2.1 20 L SD2 + 180 L DDB 10 Not used in standard

curve

SD3 20 yL SD2.1 + 180 yL DDB 10 1.00E+03

SD 4 20 pL SD3 + 180 pL DDB 10 100

SD5 20 yL SD4 + 60 yL DDB 4 25

SD 6 (LOD) 20 L SD5 + 30 pL DDB 25 10

0 Dilution volumes are sufficient for 1 standard curve in triplicates. Scale volumes accordingly for more replicates.

Store the standard curve dilution tubes at 4°C or on ice. Use the dilutions within 6 hours for gPCR.
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Serial dilutions and sample preparation for the ViralSEQ™ Lentivirus Proviral DNA Titer Kit

Extraction control guidelines

We recommend that you use the following extraction controls:

Type of control Contains Number to run Used to
Negative (NEG)!"! 1X PBS (free of Mg | 1 per batch of To monitor for contamination of the
and Ca) extractions extraction reagents.
Extraction/recovery (ERC) | Positive control from |3 per sample * Evaluate the efficiency of DNA
the kit or RNA extraction, recovery, and

quantification from test samples.
* Verify reagent and system

performance.
' Optional during routine testing.
Table 14 Starting volumes for sample extraction
Sample type Sample (uL) SD1 (L) 1 x PBS (L) Total (uL)
Sample 5 0 95 100
Sample ERC 5 5 90 100
NEG 0 0 100 100

Note: To calculate the efficiency of nucleic acid recovery and quantification from the test
samples,subtract the amount of nucleic acid measured in the sample without the addition of DNA
or RNA control from the amount of nucleic acid measured in the ERC sample.

Spike recovery calculations

For spiked samples the percent spike recovery can be calculated from the mean quantity of replicates
and the input spike quantity:

Mean quantity of replicates

Input spike quantity x 100

Spike Recovery % =

Percent spike recovery can also be calculated with respect to spiked test replicates from the mean
quantity of spiked replicates, the mean quantity of non-spiked replicates, and the input spike quantity:

(Spiked mean quantity - non-spiked mean quantity)

Input spike quantity x 100

Spike Recovery % =
The total DNA in the test samples can be calculated using the percent spike recovery with respect to
spiked test replicates and the mean quantity of non-spiked replicates:

Non-spiked mean quantity

DNA in test sample = Spike recovery

24 ViralSEQ™ Lentivirus Titer Kits User Guide



Chapter 2 Prepare reagents and serial dilutions 508

[0
Serial dilutions and sample preparation for the ViralSEQ™ Lentivirus Proviral DNA Titer Kit

Prepare the extraction/ recovery control (ERC) for the ViralSEQ™ Lentivirus
Proviral DNA Titer Kit

We recommend spiking the positive control DNA into the test sample so that the total control DNA
amount is 2- 10 times the amount of DNA measured in the test sample.

1. Add the appropriate control DNA dilution amount to the test sample.
2. Add PBS to a total volume of 100 uL.
3. Perform the sample extraction.

For example, if test sample contains 1 x 108 copies in 5 pL:

1. Add 5 pL of SD1 (1 x 107) to 5 pL of the test sample.
2. Add 90 pL of PBS (final volume of 100 pL).

3. Perform sample preparation with the PrepSEQ™ Nucleic Acid Sample Preparation Kit (on the
100 pL final volume). Elute volume is 200 pL.

4. Perform the gPCR.

Note: To calculate the efficiency of nucleic acid recovery and quantification from the test samples,
subtract the amount of nucleic acid measured in the sample without the addition of DNA or RNA control
from the amount of nucleic acid measured in the ERC sample.

The sample dilution is 1:40, so the expected copy number following gPCR is 2.5 x 105.

Triplicate extractions

Triplicate extractions are required for post-PCR analysis calculation of mean quantity, standard
deviation, and coefficient of variation.

In addition to test samples, we recommend triplicate extractions for the negative control and the
extraction/recovery control (ERC).

Perform a single PCR reaction for each extraction.

The table below illustrates the total number of extractions required based on the 1, 2, and 3 samples
extracted in a batch.

Table 15 Total number of extractions per batch of test samples

Number of test samples Total number of extractions for the batch

1 | 3 extractions required for each: 9

? * Test sample 15
¢ Test sample extraction/recovery control (ERC)

3| * Negative extraction controll'] 21

01 Optional during routine testing.
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B Manual protocol for DNA/RNA extraction ..........c.couiiiiiiin it e i 26

B Automated protocol for DNA/RNA extraction ...........coiiiiiiin it iia i 29

We recommend using the PrepSEQ™ Nucleic Acid Sample Preparation Kit (Cat. No. A50485) for sample
preparation. The kit uses chemical lysis and magnetic beads to extract nucleic acid from recombinant
lentiviruses and integrated proviruses.

Manual protocol for DNA/RNA extraction

Digest the test samples and controls

1.

2.

26

Set a block heater to 56°C. If available, set a second block heater to 70°C.

Label the Safe-Lock Tubes, 2.0-mL:
e 3 for each sample
® 3 for each sample + ERC
e 3for NEG

Add 100 pL of sample, sample + ERC, or 1X PBS (free of Mg and Ca) into each tube.
Add 10 pL of 5 M NaCl and 70 L Proteinase K/Proteinase K Buffer Il mix.
Briefly vortex and centrifuge.

Incubate at 56°C for 30 minutes.

If only one block heater is available, after this incubation step is complete, reset the block heater to
70°C for the elution step.

Note: For samples with high protein concentration, extending the incubation time to 60 minutes
can increase recovery.

Cool samples to room temperature.

Add 360 pL freshly made Lysis solution mix to each tube.
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Chapter 3 Sample extraction with the PrepSEQ™ Nucleic Acid Sample Preparation Kit P18
Manual protocol for DNA/RNA extraction

Bind the DNA/RNA

1.

8.

Vortex the Magnetic Particles to resuspend the particles.

Note: The appearance of the mixture should be homogeneous.

Add 30 pL of the Magnetic Particles to each tube.
Add 400 pL Binding Solution to the first sample, then close the cap and invert twice to mix.

Repeat step 3 for each additional sample.

Note: Low DNA recovery can be observed if the sample and the Binding Solution are not
immediately mixed.

Vortex all the tubes in the vortex adaptor for 5 minutes at 900 rpm.

Briefly centrifuge the tubes for 15 seconds at top speed (>15,000 x g) to collect the
Magnetic Particles at the bottom of the tubes.

Place the tubes in the magnetic stand with the pellet against the magnet, then let the tubes stand
for 5 minutes or until the solution is clear.

Without disturbing the magnetic beads, remove the supernatant using a pipette or by aspiration.

Wash the DNA/RNA

1.

Remove the tube rack (with tubes) from the magnetic stand, then add 300 pL of Wash Solution to
the tubes. Vortex the tubes for 5 seconds at room temperature at 900 rpm.

Centrifuge the tubes in a microcentrifuge at top speed (>15,000 x g) for a maximum of 20 seconds.
Do not centrifuge for >20 seconds.

Place the tubes in the magnetic stand, then let the tubes stand for 1 minute.

Note: The Magnetic Particles with the bound DNA/RNA are magnetically captured after
approximately 1 minute.

Without disturbing the Magnetic Particles, remove the supernatant by pipette or by aspiration.

Remove the tube rack (with tubes) from the magnetic stand, then add 300 pL of Wash Solution to
each tube for a second wash. Vortex the tubes for 5 seconds at room temperature at 900 rpm.

Centrifuge the tubes in a microcentrifuge at top speed (>15,000 x g) for a maximum of 20 seconds.
Do not centrifuge for >20 seconds.

Place the tubes in the magnetic stand, then let the tubes stand for 1 minute.

Note: The Magnetic Particles with the bound DNA/RNA are magnetically captured after
approximately 1 minute.
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[ Q]

8.

9.

10.

Open all tubes, then start the 5-minute timer.

Without disturbing the Magnetic Particles, remove the supernatant by pipette or aspiration.
Use a P200 to remove the remaining solution from the bottom of the tube.

With the tube lid open, air-dry the Magnetic Particles pellet in the magnetic stand for no more than
5 minutes at room temperature.

IMPORTANT! Air-dry to remove ethanol from the Wash Solution. Once dry, the DNA/RNA stays
bound to the magnetic beads. Do not over-dry; over-dried beads are not easily resuspended.

Elute the DNA/RNA

1.

Add Elution Buffer to each tube.
* ViralSEQ™ Lentivirus Proviral DNA Titer Kit: Add 50 pL of Elution Buffer
* ViralSEQ™ Lentivirus Physical Titer Kit: Add 200 pL of Elution Buffer

Vortex the tubes for 20 seconds at high speed, then incubate the tubes at 70°C for 7 minutes.
Vortex the tubes two to three times during the incubation to help resuspend the beads.

Centrifuge the tubes in a microcentrifuge at top speed (>15,000 x g) for a maximum of 20 seconds.
Do not centrifuge for >20 seconds.

Place the tubes in the magnetic stand, then let the tubes stand for 1 minute.

Without disturbing the Magnetic Particles, transfer the liquid phase containing the eluted DNA/RNA
to a new nonstick 1.5-mL microcentrifuge tube.

Centrifuge the tube at top speed (>15,000 x g) for 3 minutes to collect the Magnetic Particles at
the bottom of the tube, then place the tubes in the magnetic stand for 1 minute.

Without disturbing the Magnetic Particles, transfer the liquid phase containing the eluted DNA/RNA
to a new nonstick 1.5-mL microcentrifuge tube.

Note: Magnetic Particles can inhibit PCR.

Store eluted DNA/RNA for up to 6 hrs on ice, or up to 24 hrs at —-20°C.
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Automated protocol for DNA/RNA extraction

Automated protocol for DNA/RNA extraction
You can use the KingFisher™ Flex platform to automate the extraction of DNA/RNA. For all chemicals,

read the Safety Data Sheet (SDS) and follow the handling instructions. Wear appropriate protective
eyewear, clothing, and gloves.

Before each use of the kit

Ensure that you have the correct plates

The KingFisher™ Flex or the MagMAX™ Express require 5 plates.

Plate name Plate type
Lysis 96 deep-well plate
Wash 1 96 deep-well plate
Wash 2 96 deep-well plate
Elution 96 deep-well plate
Comb loading plate 96 deep-well tip comb combined with 96 standard plate

Prepare the plates
Prepare the Wash 1, Wash 2, and Elution plates:

Plate name Plate type Volume of buffer to add
Wash 1 96 deep-well plate 300 pL of Wash buffer
Wash 2 96 deep-well plate 300 pL of Wash buffer
Elution 96 deep-well plate 200 pL of Elution buffer

Prepare the lysis plate
In all steps that require pipetting, dispense liquid at bottom center of the wells.

1. Add 100 pL to the appropriate wells of the 96 deep-well Lysis plate:
* 3 wells for each sample
* 3 wells for each sample + ERC
* 3 wells for NEG

2. Add 10 pL of 5 M NaCl to each sample well.

3. Add 70 pL Proteinase K/Proteinase K (PK) Buffer Il mix to each sample well.
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Process samples on the instrument

1. Select the script or program for the instrument and kit that you are using:

Kit Instrument Script

PrepSEQ™ Nucleic Acid Sample Preparation Kit KingFisher™ Flex | PrepSEQ_NucleicAcid_v1

2. Load the plates into the instrument in the order listed below. After loading each plate, press START
to move the turntable.

a. Comb loading plate

b. Elution plate with 200 pL of Elution Buffer

(2}

. Wash 2 plate with 300 pL of wash buffer

o

. Wash 1 plate with 300 pL of wash buffer

(0]

. Lysis plate

3. Press START to begin the PK digestion process.

The instrument mixes the samples for 10 seconds at fast speed, then incubates the samples at
56°C for 30 minutes, mixing at slow speed. When digestion is complete, the instrument pauses
and returns the Lysis plate to the loading position.

4. After the digestion step is complete, add additional components to the Lysis plate:
a. Remove the Lysis plate from the instrument.

b. Add 360 pL of Lysis Solution to each sample well.
c. Add 30 pL of Magnetic Particle suspension to each sample well.

d. Add 400 pL of Binding Solution to the first sample well, then immediately pipet up-and-down
three times to mix. Repeat for each additional sample well.

Note: Low DNA recovery can be observed if the sample and the Binding Solution are not
immediately mixed.

e. Place the plate back into the instrument loading position, then press START to begin binding.

5. When DNA/RNA extraction is finished, the instrument returns the Elution plate to the loading
position.

Store eluted DNA/RNA for up to 6 hrs on ice, or up to 24 hrs at -20°C.
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Set up, run, and review ViralSEQ™
Lentivirus Physical Titer Kit
experiments

i

B Treat samples with DNase |, RNase-free (1 U/UL) . ..o ir e n 32
B Prepare the kit reagents and premix solution . ........ .. .. 33
B Prepare the PCR reactions .. ...ttt e et et et e 34
m Set up, run, and analyze samples with AccuSEQ™ Software v3.1 or later on the

QUAaNTSEUAIO™ B INSLIUMENT . ottt ettt e e ettt e e et e e e 35
B Review the resUls .. ... o e e e e e e e e 51

This section describes the general procedures to prepare PCR reactions, set up a template in the
AccuSEQ™ Real-Time PCR Software v3.1 or later, run the samples on the QuantStudio™ 5 System, then
review the results. For more information, see the AccuSEQ™ Real-Time PCR Software v3.2 User Guide
(Pub. No. MAN0029199).

Note: Check all settings, including gPCR method and optical filter selection, for correctness and
alignment with your laboratory's standard operating procedures.
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Treat samples with DNase |, RNase-free (1 U/uL)

DNase |, RNase-free (1 U/pL) treatment is used to digest double-stranded DNA.

Thaw all reagents on ice. Invert the DNase |, RNase-free (1 U/uL) several times to mix, then centrifuge
briefly. All other reagents should be vortexed, then centrifuged briefly before use.

1. Set up the DNase I, RNase-free (1 U/uL) reactions in a MicroAmp™ Optical 96-Well Reaction Plate

(0.2 mL).
Component Volume for one reaction
Nuclease-free water 4.4 L
10x DNase | Buffer 1.8 uL
Extracted RNA samplel'] 10 pL
DNase |, RNase-free (1 U/uL) 1.8 yL
Total 18 uL

' Mix gently by pipetting 3-5 times when adding.

2. Mix the reactions by gently pipetting up and down 5 times, then seal the reaction plate with
MicroAmp™ Clear Adhesive Film.

3. Centrifuge the plate at 1,000 x g for 2 minutes.

4. Load the reactions onto the VeritiPro™ 96-well Thermal Cycler, then start the DNase | treatment.
Set cover temperature: 105°C
Set reaction volume: 18 pL

Step Temperature Time
DNase | treatment 37°C 10 minutes
Hold 4°C 3-5 minutesl!

' Do not hold for more than 5 minutes. Proceed immediately to DNase | inactivation.

5. Centrifuge the plate at 1,000 x g for 2 minutes.

CAUTION! The plate is in contact with the heated lid. Remove carefully.

6. Gently remove the MicroAmp™ Clear Adhesive Film, then discard.

IMPORTANT! Do not touch wells when removing the MicroAmp™ Clear Adhesive Film.
Contamination can lead to inaccurate results.

7. Add 2 pL of 50mM EDTA to each reaction well. Mix by gently pipetting 5 times with a P10/P20
pipettor set to 10 pL.

8. Seal the reaction plate with MicroAmp™ Clear Adhesive Film, then centrifuge the plate at 1,000 x g
for 2 minutes.
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9. Load the reactions onto the VeritiPro™ 96-well Thermal Cycler, then start the DNase | inactivation.
Set cover temperature: 105°C
Set reaction volume: 20 L

Step Temperature Time
DNase | inactivation 75°C 10 minutes
Hold 4°C 3-5 minutesl'l

' Do not hold for more than 5 minutes.

10. Centrifuge the plate at 1,000 x g for 2 minutes.

CAUTION! The plate is in contact with the heated lid. Remove carefully.

IMPORTANT! Do not vortex.

Place the plate on ice until use.

Prepare the kit reagents and premix solution

Thaw all kit reagents on ice. Vortex the reagents for 5 seconds, briefly centrifuge, then place the
reagents on ice until use.

1. Label a microcentrifuge tube for the Premix Solution.

2. Prepare the Premix Solution according to the following tables.

IMPORTANT! Use a separate pipette tip for each component.

Table 16 Premix Solution

Component Volume for one 25-pL reaction | Volume for four 25-pL reactions!']
2X RT-PCR Buffer 12.5 pL 55.0 pL
25X RT-PCR Enzyme Mix 1.0 pL 4.4 yL
Physical Titer Assay Mix 2.5pL 11 pL
Nuclease Free Water 4.0 yL 17.6 pL
Total Premix Solution Volume 20.0 yL 88.0 uL

M Includes 10% excess to compensate for pipetting loss.

3. Vortex the Premix Solution for 10 seconds to mix, then briefly centrifuge.
Store the Premix Solution at 4°C or on ice until use.
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Prepare the PCR reactions

Plate setup differs slightly for each AccuSEQ™ System. See your software user guide for specific
instructions. Place samples, NTCs, and standards in different quadrants of the plate.

A factory default template is available for the ViralSEQ Lentivirus Physical Titer Kit in AccuSEQ™
Real-Time PCR Software v3.2 or later.

Place the plate containing DNase I-treated samples on a MicroAmp™ 96-Well Base, then gently remove
the MicroAmp™ Clear Adhesive Film. Gently pipette up and down 3 times to mix the samples.

1. Dispense the following into the appropriate wells of a MicroAmp™ Fast Optical 96-Well Reaction
Plate, 0.1 mL, gently pipetting at the bottom of the well.

To prepare... Combine in each tube or well...

No template control (NTC) ¢ 20 pL of Premix Solution
reaction e 5L of RNA Dilution Buffer

Unknown sample reaction ® 20 pL of Premix Solution
¢ 5 L of DNase I-treated RNA sample

Standard curve reaction ® 20 pL of Premix Solution

* 5 L of standards diluted from the RNA Control (see “Prepare the
serial dilutions” on page 20)

10 11“

' Standard
. serial

2 3 4 5 6 7 8

—

URURY A

Wells available for sample ) dilutions
testing in triplicates (SD)in
C  Total available: 24 samples ‘ triplicates

.
¢ C DO 0O

&C/uuuuuuud(_ N.TC;/)

Figure 1 Recommended plate layout

m
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2. Seal the plate with MicroAmp™ Optical Adhesive Film.

3. Vortex the reaction plate for 10 seconds, then centrifuge at 1,000 x g for 2 minutes.

Note: Ensure there are no bubbles in the reaction wells. If present, tap the well gently to remove
bubbles, then recentrifuge.

Set up, run, and analyze samples with AccuSEQ™ Software
v3.1 or later on the QuantStudio™ 5 Instrument

Sign in to the AccuSEQ™ Real-Time PCR Software

Thermo Fisher Scientific recommends configuring the Windows™ 10 screen save feature to require
sign in when the screensaver is activated. This prevents other users from accessing the AccuSEQ™
Real-Time PCR Software and making changes.

1. Launch the AccuSEQ™ Real-Time PCR Software by double-clicking the AccuSEQ icon Edl.

2. Enter the Username, then Password.

(First login only) The default username is Administrator and the default password is
Administrator.

3. Click Sign in.

sign In

AccuSEQ

Real-Time PCR Software

Version 3.1 Password
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The following restrictions may be seen in the software:

* Access to functions in the software is based on the permissions associated with the individual user
account.

¢ If a user account does not have permission to perform a function, the function is grayed out in the
software.

¢ |f the system is configured for password expiration, you will be periodically prompted to change
your password. If the system is configured to monitor failed log in attempts, you will be locked out
of the software if you incorrectly enter your user name or password more than a specified number
of times.

Create a ViralSEQ™ template in AccuSEQ™ Real-Time PCR Software v3.1

Create a new template in the /A (Home) screen of the AccuSEQ™ Real-Time PCR Software v3.1.

Note: AccuSEQ™ Real-Time PCR Software v3.2 or later has a Factory default/Admin Defined
Template for the ViralSEQ™ Lentivirus Physical Titer Kit. See “Create a ViralSEQ™ Lentivirus Physical
Titer Kit experiment in AccuSEQ™ Real-Time PCR Software v3.2 or later” on page 42.

1. Click 4+ Create New on the home screen.

@— Create New Experiment

P ®
ﬁ Factory default/Admin Defined Templates . My Templates + Create New

Create New Experiment Create My Template Create Admin Defined Template

(1) Create New Experiment pane

@ Factory default/Admin Defined Templates —List of existing default or Admin Defined templates. These templates can be
used as templates for new experiments.

@ My Templates —List of templates available to the user that is signed in. These templates can be used as templates for new
experiments.

@ Create New—Used to create an experiment or template with no pre-existing settings.
@ Create My Template —Used to create a new template (stored locally in My Templates).
@ Create Admin Defined Template—Used to create a new template (Administrator only).

2. Select Create My Template or Create Admin Defined Template.
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3. Edit the Experiment Properties as required.

Setup Audit 4} Analysis Settings
o Experiment Properties — 00— o gqPCR Method —m09m™ 98 ——— C) Plate Setup

& Experiment Type

| @
Quantitation - Standard Curve Melt Curve 4
Template_2020-09-18_7800 _ ‘—I

Chemistry

{Optional) TagMan ® Reagents ‘ SYBR ® Green Reagents ‘ ‘ Other I‘@

Ramp Speed

Block Type

96- Well 0.1mL Block

Is Locked

T

@ @

@ Software-generated Template Name @ Ramp Speed

(2 Barcode field (@ Block Type (fixed as a 96-Well 0.1mL block).

@ Comments field Is Locked checkbox (Only Administrators can create locked
(@ Experiment Type Admin Defined Templates).

(3 Chemistry (9 Analysis Settings

a. In the Template Name field, modify the template name. For example, LV Titer template.
b. (Optional) Enter information in the Comments field.

c. In the Setup tab, select:
* Experiment Type —Quantitation-Standard Curve
* Chemistry—TagMan ® Reagents
¢ Ramp Speed—Standard-2hrs
¢ Block Type—96-Well 0.1mL Block

d. (Optional) Select Is Locked to lock the template. If locked, users are unable to edit the
template.

4. Click £*Analysis settings to change the default C; Settings and Flag Settings.
a. In the C; Settings tab, click Edit Default Settings.

b. Deselect Automatic Threshold, then enter 0.200.
c. Ensure that Automatic Baseline is selected.

d. Click Save Changes.
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e. Deselect Default Settings, then click Apply to save any changes before closing the window.

@— Ct Settings

Data Step Selection
PCR Stage/step
Stage2/Step2

Target =
IPC

Lentivirus

? Analysis Settings

Flag Settings Advanced Settings

Default Ct Settings

Threshold : Auto Baseline Start Cycle : Auto Baseline End Cycle : Auto Edit Default Settings
Threshold Baseline Start ¢ Baseline End ¢ Ct Settings for Lentivirus

Ct Settings to Use
0.200 Auto Auto
Default Settings

0.200 Aute Auto

Automatic Threshold Automatic Baseline

0.200

@ C; Settings

@ Flag Settings

@ Edit Default Settings button
@ Default Settings checkbox

@ Apply button

f.

In the Flag Settings tab, deselect the following flags.
¢ CQCONF—Low Cqg confidence
e EXPFAIL—Exponential algorithm failed
* NOAMP —No amplification
* NOSIGNAL—No signal in well

e )
(5)

Note: Use the scrollbar on the right to scroll down the list of flags.

g. Click Apply to save any changes before closing the window.

5. Click Next.
Template name cannot be changed after this step.

The gPCR Method screen is displayed.

38
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Edit the run method and optical filter selection

This section provides general procedures to edit the run method and optical filter selection in the gPC
Method. To edit the default run method, see the AccuSEQ™ Real-Time PCR Software v3.1 User Guide
(Pub. No. 100094287).

1. Set the reaction volume to 25 pL.

2. Edit Step 1 of the Hold Stage to 45°C for 30 minutes.
3. Set Step 2 of the Hold Stage to 95°C for 10 minutes.

4. Set Step 1 of the PCR Stage to 95°C for 15 seconds.
5. Edit Step 2 of the PCR Stage to 60°C for 45 seconds.
6. Set the cycle number to 40.

7. Ensure that Data Collection occurs after Step 2.

®_ 25 pL 105°C
@— Hold Stage PCR Stage
%°C | Jgs BT N
y 10:00 0015 1H.E~~E;S
1.66/S W 2 60 °C
asc | A .. 00:45
1608 30:00 _ 10
o [
Step 1 Step 2 Step 1 Step 2
<:>_ 40x
Legend
=) Data Caollection On jata Collection Off e Advanced Setting V Verflex A Auto Delta

Figure 2 Lentivirus Physical Titer Run Method

@ Reaction volume- set to 25uL

() Stage

@ Cycle number- set to 40 cycles
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8. (Optional) Click Y (Optical Filter Settings) to view the default filter settings.
* The default optical filter selection is suitable for the ViralSEQ™ Lentivirus Physical Titer Kit.

* The ViralSEQ™ Lentivirus Physical Titer Kit requires the QuantStudio™ 5 System to be
calibrated for FAM™, VIC™, and ROX™.

* For more information about system dyes and their calibration and optical filter selection, see
QuantStudio™ 3 and 5 Real-Time PCR Systems Installation, Use, and Maintenance Guide
(Pub. No. MANO0010407).

9. Click Next.

Assign plate and well attributes

Note: This section provides general procedures to set up the plate.
For specific instructions for each assay type, see the corresponding chapter in this guide. Do not
change Targets for default assay templates.

Lt

o

-®

® v ||sectmem ¥ seictitem :

@ Targets (2} Add s X

Color  Name:  Roporter  Quanchar Task <
] Lentiviru 5 FAM NFO-MGE - f il - W
- || ] [ 1] |
IPC wc NFO-MGB X — Yomoses 1 Doocom
W = B g o] ] o}
- - e ] | (WSS
@ Samgies ) B
Calor Namw & Diution Factor  Sampile Volume Splke Volume _'"“ e A
1] ]
n Sampia 1 1.00 00 0.0 Ilﬂ” R = "Tal.\. -
n mple 2 1.00 (1 (1] 1) o
] ]
[ ] son 1.00 0.0 o8 -
[ [ul
[ | 502 1.00 o 0. % E ﬁ
] 503 1.00 00 0.
[ | S04 .00 oo ==
505 1.00 0.0 |
L 308 1.00 00 00T el [ zr [ 3 [B15 []69 Emety) 0%
ROX v
(D Targets
(2 Samples

(3 Plate setup toolbar

@ Select Item to highlight (Sample, Target, or Task).

@ Select Item. For example, Sample 1. Sample 1 replicates are highlighted.
@ Define & setup Standard

@ (View Legend)

& (Print Preview)

(9) View (Grid View or Table View)

40 ViralSEQ™ Lentivirus Titer Kits User Guide



Chapter 4 Set up, run, and review ViralSEQ™ Lentivirus Physical Titer Kit experiments ~ 8

<
| /]

Set up, run, and analyze samples with AccuSEQ™ Software v3.1 or later on the QuantStudio™ 5 Instrument

1. In Plate Setup screen, click or click-drag to select plate wells in the gg (Grid View) of the plate.

2. Assign the well attributes for the selected wells. Each well should have a Sample Name under
Samples, as well as the appropriate Targets under Targets. Reporters should be FAM™ dye for
Lentivirus Physical Titer, and VIC™ dye for internal positive control (IPC).

a.

To add new Samples or Targets, click Add in the appropriate column on the left of the
screen, then edit the new Name and other properties as required. The new sample or target is
then selectable within the wells of the plate.

For each sample (e.g. DNase-treated lentivirus sample, standard curve dilution, or NTC), two
targets should be included.

® Select the FAM™ dye reporter for Lentivirus Physical Titer detection.
* Select the VIC™ dye for IPC detection.

. Select NFQ-MGB as the quencher for both targets.

For standard curve dilution samples (SD1 to SD5), the Task for Lentivirus Physical Titer target
should be indicated as “S” for Standard, with the appropriate copy number written under
Quantity. For instance, the quantity for SD1 is 1E9 copies. Change the Task by clicking on
the field and using the drop-down menu. Copy numbers can be indicated using scientific
notation (e.g. “1E9”) and the program will convert it to numerical format.

. For DNase-treated samples and SD6, set the Task for Lentivirus Physical Titer target to U for

Unknown.

For NTC wells, set the Task for Lentivirus Physical Titer target to N for NTC.

. For IPC wells, set the Task for Lentivirus Physical Titer target to U for Unknown.
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h. To change sample names, click the name in the Name column, then type the new name. To
change Reporters and Quenchers, click the dye, then select from the dropdown list.

When a Sample or Target name are edited, two entries are added to the Audit trail (one for
Delete, and another for Create).

Samples (13) Add

@— Color Mame = Dilution Factor  Sample Volume Spike Volume

@ [ | ENC 1.00 0.0 0.0
EPC 1.00 0.0 0.0

|| NTC 1.00 0.0 0.0

[ | PTC 1.00 0.0 0.0

[ | 51 1.00 0.0 0.0

[ | S1 EPC 1.00 0.0 0.0

51 Spk ... 1.00 0.0 0.0

51 Spk ... 1.00 0.0 0.0

B  51Spk.. 1.00 0.0 0.0

@_

(D) Add button
@ Checkbox—Select Targets and Samples to go in the selected well.
@ Textbox—Click the name to edit.
@ Scrollbar—Use to scroll to additional properties.
® Use the plate setup toolbar (above the plate) to make edits to the plate.

- Click (@ View to show/hide the Sample Name, Sample Color, or Target from the
view.

* To add consecutive samples (with the same Target), select a well, then click-drag the
dark blue box to the right.

3. (Optional) Double-click a well to enter comments for the selected well.
4. Select ROX™ dye from the Passive Reference drop-down list (bottom left of screen).

5. Click Save to save the template.
This template can then be used to create experiments.

Create a Viral[SEQ™ Lentivirus Physical Titer Kit experiment in AccuSEQ™
Real-Time PCR Software v3.2 or later

1. In the /A Home screen, click the Factory default/Admin Defined Template tab, then select a
ViralSEQ Lentivirus Physical Titer Kit template.

To navigate to through the available templates click the arrows to either side of the available
templates.
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Create New Experiment

— ®
ﬁ Factory default/Admin Defined . My Templates + Create New
Templates
O ViralSEQ MMV Dete... ViralSEQ Vesivirus ... MycoSEQ Plus Myc... ViralSEQ Quantitativ... Quantitative Kanam... @

To create an experiment from an existing ViralSEQ™ Lentivirus Physical Titer Kit experiment, see
AccuSEQ™ Real-Time PCR Software v3.2 User Guide (Pub. No. MAN0029199).

2. In the Experiment Properties pane of the Setup screen:
a. (Optional) Change the system-generated name of the experiment.

Note: Names must be unique. Deleted experiment names can not be reused.

b. (Optional) Enter the plate barcode in the Barcode field, then add comments in the Comments
field.

Note: Comments are not editable post analysis.

Default ViralSEQ™ Lentivirus Physical Titer Kit settings (cannot be changed)
¢ Experiment Type—Quantitation-Standard Curve
* Chemistry—TagMan™ Reagents
* Ramp Speed—Standard - 2hrs

c. Click Next.

Note: Experiment names cannot be changed after this step.

3. In the gPCR Method pane of the Setup screen, view the default volume and cycling conditions
(cannot be changed).

Note: This assay is run with a Standard ramp speed (2hrs).
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Hold Stage PCR Stage
95 °C 95 °C
1.6 “C/S
10:00 00:15
1.8.C/S
1.6 26/S e d Ex b R
45 °C 00:45
1.6 2G4S 30:00 # m
-
Step 1 Step 2 Step 1 Step 2
40x

Figure 3 ViralSEQ™ Lentivirus Physical Titer Kit template default cycling conditions

4. Click Next.

5. In the Samples table in the Plate Setup pane, enter the sample name and sample volume. Click
Add to add more samples if needed.

Note: The software calculates viral particles per mL if the sample volume was entered.

IMPORTANT! Do not change the Targets.

(1)—Samples (24) Add
Color Name = Dilution Sample Volume

1A 100 o

4k

[ | 1B 1.00 0.00

@ Samples table
(2) Add—adds more samples
For more information about plate setup, see “Assign plate and well attributes” on page 40.

* Sample Volume —add sample volume to calculate viral particles per mL in the results.
* Spike Volume—volume of DNA added to the PCR (set to 10).

¢ Spike Standard Concentration—expected spike amount per reaction (for example,
10 copies).

* Reference—the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

44 ViralSEQ™ Lentivirus Titer Kits User Guide



@5

Chapter 4 Set up, run, and review ViralSEQ™ Lentivirus Physical Titer Kit experiments

| ZL

Set up, run, and analyze samples with AccuSEQ™ Software v3.1 or later on the QuantStudio™ 5 Instrument

Spike Input—calculated (double check if correct).

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is

the expected copies spike per PCR reaction.

Protein Concentration—Drug substance protein concentration (if total DNA
copies RNA/mg protein is needed).

(Optional) Comments

Samples (24) Add

Spike Volume Spike Standard Concentratior
N 0.00
0.00 0.00
0.00 0.00
0.00 0.00

@— »

@ Textbox—type in the value, or use the up and down arrows

@ Scroll bar—scroll to find the spike parameter

@_ | |::. °||®"| Select tem ¥ || select ltem v
1 2 3 4

Lenti-1

A | e
MWirc ==
Lenti-2 L]

B | [llLent-A._=x
Wipc ==
Lenti-3

¢ | [Mlieni-n. "=
MWirc ==
Lenti-4 L}

0 | [ientin. ==
MWiec ==

E

F

a

H

Define & setup Standard

5 6 7 & 9 10
Lenti-1 Lenti-1 L1-ANA L}
PC "x PC "x 1.0000E+9
] ] e,

Lenti-2 B Lenti-2 L] L2-RNA
B entir.®x | | [ LentiR.=x ElLenti-n. =
Pe Pe x 1.0000E+7
] = Wirc ==
Lenti-3 Lenti-3 L3-ANA L}
PC "x PC "x 1.0000E+5
@ @ Wiec ==
Lenti-4 | Lenti-4 L] La-FNA =
] Lenti-.. == B Lentir..=x ElLentin. ==
Pe PC "x 1.0000E+3
o m Wirc ==
L5-RNA Ll
ElLentir. =
50.0000
Wiec ==
LE-RNA L}
[ Lenti-p. ==
MWiec ==

NTC-RDB Ll

[H] Lenti-.. ==
MWiec ==

wells: [l 33 [N]3 [8]15 [ |63 (Empty)

Figure 4 ViralSEQ™ Lentivirus Physical Titer Kit template default sample plate layout

(@ Toolbar (in order: O Undo, C Redo, (7] Copy, Il Paste, € Delete, @View)
@ Select type (Sample, Target, or Task) to highlight.

@ Select specific items of that type. For example, Sample 1. Sample 1 replicates are highlighted.
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Table 17 Plate well descriptions

Name Description
Lenti-1 to Lenti-4 4 samples in triplicate
L1-RNA to L6-RNA Standard curve dilutions in triplicate
NTC-RDB No template control in triplicate

6. (Optional) Double-click wells to add comments. Comments can also be added post-analysis.

Comments

B Sampled B Samplein B

7. Click Next.
The Run screen is displayed.

8. Experiments are auto-saved in the software. To save, exit the experiment. The software prompts
you to save changes. Click Yes.

Note: Clicking B Save As creates a copy of the experiment.

9. (Optional) Click "= Print to print the plate layout for use in preparing the reactions.

10. Assemble the PCR reactions following the instructions of the manufacturer for the reagents and
following the plate layout set up in the template.
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Load the plate in the instrument

CAUTION! Use optical flat caps for tubes. Rounded caps can damage the heated cover.

Load the plate.
1. Touch ® to eject the instrument drawer.

2. Load the plate onto the plate adapter so that:
e Well A1 of the plate is in the top-left corner of the plate adapter.
¢ The barcode faces the front of the instrument.

A1
§
(VAN

IMPORTANT! The instrument should be used by trained operators who have been warned of the
moving parts hazard.

Note: Do not remove the black plate adapter before loading a plate or tube strips. If used, tube
strips can fit loosely in the adapter, but the heated cover applies the appropriate pressure to seat
the tube strips securely in the adapter.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the plate temperature
can reach 100°C. Allow it to cool to room temperature before handling.

3. Touch @ to close the instrument drawer.
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Start the run (QuantStudio™ 5 Real-Time PCR Instrument)

Ensure that the plate is loaded in the QuantStudio™ 5 Real-Time PCR Instrument.

Start the run in the AccuSEQ™ Software v3.1 or later.

Option Description

If the experiment is open Click Start Run.

If the experiment is closed a. Open the experiment.

b. Click the Run tab.
c. Click Start Run.

Run Control

Ampatication Piot ?

wens: [l 27 [[2 815 [ 6o @mpty

@ Run tab
Start Run button

A message stating Run has been started successfully is displayed when the run has started.
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Monitor the run

During the instrument run, you can monitor the run from the following places:

¢ On the instrument touchscreen.
¢ In the Monitor the Run pane of the AccuSEQ™ Software 4 (Home) screen.

Monitor The Run

Q- PA-QS5-03
(@ gm— Running

(© - Calibrated

2020-06-01_8926

@ Instrument name
Instrument status (Ready, Running, Offline)
Calibration status
— Calibrated —All required calibrations are "Current". Required calibrations include: Background,
ROI/Uniformity, and Dyes.
— Not calibrated —None of the required calibrations are complete.
— Requires calibration—One or more dyes are not calibrated.
@ Time lapsed (if a run is in progress)
Total run time
Experiment name
¢ In the Open Existing Experiments pane of the AccuSEQ™ Software A (Home) screen. The
experiment being run is the first experiment listed. Status is Run.

Note: You cannot start another run while the instrument status is Running.
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When the run is complete, the status changes to Analysis and the status bar displays as complete.

@— Open Existing Experiments

2020-06-04_2696

@— Run

2020-06-04_8175

Setup

@ Open Existing Experiments pane
Experiment status

¢ In the Run tab of the AccuSEQ™ Real-Time PCR Software.
You can perform the following actions.
— Select wells in the plate layout to highlight respective curves in the plot.
— Hover over curves in the plot for well information.
— (Optional) Change what is displayed in the table wells, by selecting Sample Name, Sample
Color, or Target in the View dropdown list.

On run completion, the Post Run Summary displays the run length, user and instrument information,
and a list of any errors that occurred.

When the run is complete, unload the plate from the instrument.
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A
Review the results
After the gPCR run is finished, use the following general procedure to analyze the results.
For more detailed instructions see the AccuSEQ™ Real-Time PCR Software v3.2 User Guide
(Pub. No. MAN0029199).
1. In the AccuSEQ™ Real-Time PCR Software, open the experiment, then navigate to the Result
screen.
Setup Fiur Result Report Audit & E-Sigr £ Analysis Settings [ A v As Temy EE t Exg t
Result Summary Result Analysis
Plots & Summary Results
¢ = @ |on| | E
> ] 0 1
e
. -
B omc om-
et i
- — =1
A T (o
[/ P
L:"‘Nl LGCLJ L’f‘ﬂﬂl
- o u-
T e
EWL1-ANA EL2-ANA EL3ANA EL4RNA EL5-RNA B LSA-RNA B LG-RNA . . . . .
B NTC-RDB cr (=3 cn
wells: [@24 [{]2 Bl [] 72 Empty) 0%

®

(D Result screen

@ Analysis Settings

(3 Plot horizontal scrollbar
@ Analyze button

2. In the Result Analysis tab, select individual targets, then review the Amplification Curve plots for

amplification profiles in the controls, samples, and the standard curve. Ensure that threshold is set
to 0.200 with an automatic baseline.

Note: If any settings are changed, click the Analyze button to apply the new settings to the

results. Target names and Sample names (under the Setup tab) can also be changed after the run
is completed.

3. In the Result Analysis tab, review the QC Summary for any flags in wells.
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4. In the Result Analysis tab, review the Standard Curve plot. Verify the values for the Slope,
Y-intercept, R2, and Efficiency are within acceptable limits.

Result Summary Result Analysis

Plots & Summary

Amplification Multicomponant Haw Data Standard Curve O Summany

k ] &, a b - Targets - & s Linaar- MNona-

Standard Curve Plot

Tarl Taed Te+d Tard la+h lath Ta+T Tasd Ta+h

Quantity

Target: Lenti-RMA, Slope: -3 2828, B2 0959593, Y-Intercepl: 37,7740, EMcency: 101 66
StdEror -0.0208 |

B Siandard B Unknown (5

@ Slope, R?, and Efficiency values

Note: The Standard Curve efficiency should be between 90-110% and the R?>0.99. If these
criteria are not met, up to two points, not in the same triplicate, can be removed from the standard
curve data, and the analysis repeated.

5. In Table View, ensure that C; values are within the standard curve range.

e Samples with C; values that exceed the upper limit of quantitation (10° copies) of the standard
curve should be diluted and run again.

* Samples with C; values that exceed the lower limit of detection (LoD of 10 copies) and IPC
shows no signs of PCR inhibition, suggests the absence of lentivirus.

6. (Optional) Outliers can be excluded from the results. To exclude, select the well, then click
Omit/Include, then reanalyze by clicking Analyze.

7. (Optional) Select File » Print Report to generate a hard copy of the experiment, or click Print
Preview to view and save the report as a PDF or HTML file.
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8. Export the results.
a. Navigate to the Report screen.

b. Check all boxes under Contents.

(2}

. Select Export Data in One File.

d. Select the XLS format, then click Export.

Calculate the titer (VP/mL)

Note: After analysis, AccuSEQ™ Software v3.2 or later provides the titer in viral particles per mL in the
table view of the Results screen. Use of the Physical Titer Calculation Tool is not needed.

1. Download the Physical Titer Calculation Tool.
a. Go to thermofisher.com.

b. Search for the ViralSEQ™ Lentivirus Physical Titer Kit.
c. Download the tool from the Documents section.

2. Open the tool, then follow the instructions in the tool to calculate the titer.

Analyze the data without AccuSEQ™ Real-Time PCR Software
1. Set the threshold to 0.2 and use automatic baseline.
2. Export the C; values to a Microsoft™ Excel™ spreadsheet.
3. For the standard curve, plot logg of the standard quantity versus the mean C;.
4. Determine the equation of the standard curves by adding a trendline and displaying the equation.

5. Determine the quantity of the unknown samples using the C; values and the equation generated
from the trendline.
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Calculate lentivirus titers from gPCR data

To determine the number of lentivirus RNA copies per mL in the original sample, the copy numbers
obtained from the gPCR must be multiplied by the dilution factor of the sample during extraction and
DNase | treatment. Since there are 2 copies of RNA/target per lentivirus particle, the number of viral
particles per mL (VP/mL) is 0.5x the number of lentivirus RNA copies.

gPCR copies x sample dilution factor x 0.5
Volume of sample used (mL)

Viral particles per mL =

For help in determining the gPCR copy numbers, see the QuantStudio™ Design and Analysis Desktop
Software User Guide (Pub. No. MANOO10408).

For example, if the following parameters were used,

¢ 10 L of lentivirus culture was extracted with the KingFisher™ Flex Purification System with 96
Deep-Well Head and eluted in 200 pL

e 10 pL of this eluate (20x dilution) was treated with DNase I, RNase-free (1 U/uL) in a total volume of
20 L.

e 5 L of the DNase-treated sample (4x dilution) was used for the gPCR reaction.

Use 10 uL Use 5 pL
B (1:20 dilution) (1:4 dilution)
Lentivirus sample Sample Extraction DNasel Treat RT-gPCR
10 L Elute: 200 pyL Total: 20 yL reaction Total: 25 L reaction

then, the calculation would be:

. . _ gPCR copies x (20x4) x 0.5
Viral particles per mL = 0.01 (mD)

Note: gPCR can only determine the number of physical particles in a virus culture. To determine the
numbers of infectious units, cell-based transduction experiments must be carried out. The titers of
physical particles are often higher than infectious titers by 10-1000 fold, depending on the purity of the
lentivirus preparation and the levels of infectious particles within the culture.
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This section describes the general procedures to prepare PCR reactions, set up a template in the
AccuSEQ™ Real-Time PCR Software v3.1 or later, run the samples on the QuantStudio™ 5 System, then
review the results. For more information, see the AccuSEQ™ Real-Time PCR Software v3.2 User Guide

(Pub. No. MAN0029199).

Note: Check all settings, including gPCR method and optical filter selection, for correctness and
alignment with your laboratory's standard operating procedures.

Prepare the kit reagents and premix solution

Thaw all kit reagents on ice. Vortex the reagents for 5 seconds, briefly centrifuge, then place the

reagents on ice until use.

1. Label a microcentrifuge tube for the Premix Solution.

2. Prepare the Premix Solution according to the following tables.

IMPORTANT! Use a separate pipette tip for each component.

Table 18 Premix Solution

Component Volume for one 30-pL reaction | Volume for four 30-pL reactions!']
2 X Environmental Master Mix 15.0 yL 66.0 pL
Proviral DNA Titer Assay Mix 6.0 pL 26.4 yL
Nuclease Free Water 4.0 uL 17.6 L
Total Premix Solution Volume 25.0 yL 110.0 yL

' Includes 10% excess to compensate for pipetting loss.

3. Vortex the Premix Solution for 10 seconds to mix, then briefly centrifuge.
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Prepare the PCR reactions

Plate setup differs slightly for each AccuSEQ™ System. See your software user guide for specific
instructions. Place samples, NTCs, and standards in different quadrants of the plate.

A factory default template is available for the ViralSEQ Lentivirus Proviral DNA Titer Kit in AccuSEQ™
Real-Time PCR Software v3.2 or later.

1. Dispense the following into the appropriate wells of a MicroAmp™ Fast Optical 96-Well Reaction
Plate, 0.1 mL, gently pipetting at the bottom of the well.

To prepare... Combine in each tube or well...
No template control (NTC) e 25 L of Premix Solution
reaction * 5L of DNA Dilution Buffer
Unknown sample reaction e 25 pL of Premix Solution

* 5L of sample

Standard curve reaction ® 25 pL of Premix Solution

* 5 L of standards diluted from the DNA Control (see “Prepare the
serial dilutions” on page 23)

A 2 3 4 5 6 7 8 9 10 1 A
) |

Standard
C C ) . serial

o Wells available for sample Y dilutions
testing in triplicates (SP) in
e C  Total available: 24 samples ) triplicates

FC DX
6 C )OO0

&C/uuuuuuud(_ N.TC:/

Figure 5 Recommended plate layout

2. Seal the plate with MicroAmp™ Optical Adhesive Film.

3. Vortex the reaction plate for 10 seconds, then centrifuge at 1,000 x g for 2 minutes.

Note: Ensure there are no bubbles in the reaction wells. If present, tap the well gently to remove
bubbles, then recentrifuge.
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Set up, run, and analyze samples with AccuSEQ™ Software
v3.1 or later on the QuantStudio™ 5 Instrument

Sign in to the AccuSEQ™ Real-Time PCR Software

Thermo Fisher Scientific recommends configuring the Windows™ 10 screen save feature to require
sign in when the screensaver is activated. This prevents other users from accessing the AccuSEQ™
Real-Time PCR Software and making changes.

1. Launch the AccuSEQ™ Real-Time PCR Software by double-clicking the AccuSEQ icon .

2. Enter the Username, then Password.

(First login only) The default username is Administrator and the default password is
Administrator.

3. Click Sign in.

Sign In

AccuSEQ

Real-Time PCR Software

Version 3.1 Password

The following restrictions may be seen in the software:
* Access to functions in the software is based on the permissions associated with the individual user
account.
¢ If a user account does not have permission to perform a function, the function is grayed out in the
software.

¢ If the system is configured for password expiration, you will be periodically prompted to change
your password. If the system is configured to monitor failed log in attempts, you will be locked out
of the software if you incorrectly enter your user name or password more than a specified number
of times.
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Create a ViralSEQ™ template in AccuSEQ™ Real-Time PCR Software v3.1

Create a new template in the A (Home) screen of the AccuSEQ™ Real-Time PCR Software v3.1.

Note: AccuSEQ™ Real-Time PCR Software v3.2 or later has a Factory default/Admin Defined
Template for the ViralSEQ™ Lentivirus Proviral DNA Titer Kit. See “Create a ViralSEQ™ Lentivirus Proviral
DNA Titer Kit experiment in AccuSEQ™ Real-Time PCR Software v3.2 or later” on page 64.

1. Click 4+ Create New on the home screen.

@— Create New Experiment

P ®
ﬁ Factory default/Admin Defined Templates - My Templates + Create New

Create New Experiment Create My Template Create Admin Defined Template

@ Create New Experiment pane

@ Factory default/Admin Defined Templates —List of existing default or Admin Defined templates. These templates can be
used as templates for new experiments.

@ My Templates —List of templates available to the user that is signed in. These templates can be used as templates for new
experiments.

@ Create New—Used to create an experiment or template with no pre-existing settings.
@ Create My Template —Used to create a new template (stored locally in My Templates).
@ Create Admin Defined Template—Used to create a new template (Administrator only).

2. Select Create My Template or Create Admin Defined Template.
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3. Edit the Experiment Properties as required.

Setup Audit 4} Analysis Settings
o Experiment Properties — 00— o gqPCR Method —m09m™ 98 ——— C) Plate Setup

& Experiment Type

| @
Quantitation - Standard Curve Melt Curve 4
Template_2020-09-18_7800 _ ‘—I

Chemistry

{Optional) TagMan ® Reagents ‘ SYBR ® Green Reagents ‘ ‘ Other I‘@

Ramp Speed

Block Type

96- Well 0.1mL Block

Is Locked

T

@ @

@ Software-generated Template Name @ Ramp Speed

(2 Barcode field (@ Block Type (fixed as a 96-Well 0.1mL block).

@ Comments field Is Locked checkbox (Only Administrators can create locked
(@ Experiment Type Admin Defined Templates).

(3 Chemistry (9 Analysis Settings

a. In the Template Name field, modify the template name. For example, LV Titer template.
b. (Optional) Enter information in the Comments field.

c. In the Setup tab, select:
* Experiment Type —Quantitation-Standard Curve
* Chemistry—TagMan Reagents
¢ Ramp Speed—Standard-2hrs
¢ Block Type—96-Well 0.1mL Block

d. (Optional) Select Is Locked to lock the template. If locked, users are unable to edit the
template.

4. Click £*Analysis settings to change the default C; Settings and Flag Settings.
a. In the C; Settings tab, click Edit Default Settings.

b. Deselect Automatic Threshold, then enter 0.200.
c. Ensure that Automatic Baseline is selected.

d. Click Save Changes.
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e. Deselect Default Settings, then click Apply to save any changes before closing the window.

@— Ct Settings

Data Step Selection
PCR Stage/step
Stage2/Step2

Target =
IPC

Lentivirus

? Analysis Settings

Flag Settings Advanced Settings

Default Ct Settings

Threshold : Auto Baseline Start Cycle : Auto Baseline End Cycle : Auto Edit Default Settings
Threshold Baseline Start ¢ Baseline End ¢ Ct Settings for Lentivirus

Ct Settings to Use
0.200 Auto Auto
Default Settings

0.200 Aute Auto

Automatic Threshold Automatic Baseline

0.200

@ C; Settings

@ Flag Settings

@ Edit Default Settings button
@ Default Settings checkbox

@ Apply button

f.

In the Flag Settings tab, deselect the following flags.
¢ CQCONF—Low Cqg confidence
e EXPFAIL—Exponential algorithm failed
* NOAMP —No amplification
* NOSIGNAL—No signal in well

e )
(5)

Note: Use the scrollbar on the right to scroll down the list of flags.

g. Click Apply to save any changes before closing the window.

5. Click Next.
Template name cannot be changed after this step.

The gPCR Method screen is displayed.

60
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Edit the run method and optical filter selection

This section provides general procedures to edit the run method and optical filter selection in the gPCR
Method. To edit the default run method, see the AccuSEQ™ Real-Time PCR Software v3.2 User Guide
(Pub. No. MAN0029199).

1. Set the reaction volume to 30 pL.

2. Set Step 1 of the Hold Stage to 95°C for 10 minutes.
3. Set Step 1 of the PCR Stage to 95°C for 15 seconds.
4. Edit Step 2 of the PCR Stage to 60°C for 1 minute.
5. Set the cycle number to 40.

6. Ensure that Data Collection occurs after Step 2.

pL 105°C

Figure 6 Lentivirus Proviral Titer Run Method

@ Reaction volume- set to 30pL

() Stage

@ Cycle number- set to 40 cycles
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7. (Optional) Click ¥ (Optical Filter Settings) to view the default filter settings.
* The default optical filter selection is suitable for the ViralSEQ™ Lentivirus Proviral DNA Titer Kit.

* The ViralSEQ™ Lentivirus Proviral DNA Titer Kit requires the QuantStudio™ 5 System to be
calibrated for FAM™, VIC™, and ROX™.

* For more information about system dyes and their calibration and optical filter selection, see
QuantStudio™ 3 and 5 Real-Time PCR Systems Installation, Use, and Maintenance Guide
(Pub. No. MANO0010407).

8. Click Next.

Assign plate and well attributes

Note: This section provides general procedures to set up the plate.
For specific instructions for each assay type, see the corresponding chapter in ViralSEQ™ Lentivirus
Titer Kits User Guide (Pub. No. MAN0026126). Do not change Targets for default assay templates.

@=L h?ﬁ? i@ | o C? ?y@

Coler  Wame s Mepoes  Cusnchar

m 5t § i
- -
@ 7 = - E
Cobor  Hame:  Ohuson Facter  Saeple Volume  lon Vokamy
| | B ]
™1 - . i B -
= arrices L [ o B
= = [ ]
™ s o = e
- : == 8 i
] i
] J .
: | R S
= B EE .

(@) Targets

@ Samples

(3 Plate setup toolbar

@ Select Item to highlight (Sample, Target, or Task).

@ Select Item. For example, Sample 1. Sample 1 replicates are highlighted.
@ Define & setup Standard

@ (View Legend)

&= (Print Preview)

@ View (Grid View or Table View)
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Set up, run, and analyze samples with AccuSEQ™ Software v3.1 or later on the QuantStudio™ 5 Instrument

1. In Plate Setup screen, click or click-drag to select plate wells in the gg (Grid View) of the plate.

2. Assign the well attributes for the selected wells. Each well should have a Sample Name under
Samples, as well as the appropriate Targets under Targets. Reporters should be FAM™ dye for
Lentivirus Proviral Titer, and VIC™ dye for internal positive control (IPC).

a.

To add new Samples or Targets, click Add in the appropriate column on the left of the
screen, then edit the new Name and other properties if needed. The new sample or target is
then selectable within the wells of the plate.

For each sample (for example DNase-treated lentivirus sample, standard curve dilution, or
NTC), two targets should be included.

* Select the FAM™ dye reporter for Lentivirus Proviral Titer detection.
* Select the VIC™ dye for IPC detection.

. Select NFQ-MGB as the quencher for both targets.

For standard curve dilution samples (SD1 to SD5), the Task for Lentivirus Proviral Titer target
should be indicated as S for Standard, with the appropriate copy number written under
Quantity. For instance, the quantity for SD1 is 1E7 copies. Change the Task by clicking on
the field and using the dropdown menu. Copy numbers can be indicated using scientific
notation (for example “1E7”) and the program converts it to numerical format.

. For unknown or test samples and SDB6, set the Task for Lentivirus Proviral Titer target to U for

Unknown.

For NTC wells, set the Task for Lentivirus Proviral Titer target to N for NTC.

. For IPC wells, set the Task to U for all samples.
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h. To change sample names, click the name in the Name column, then type the new name. To
change Reporters and Quenchers, click the dye, then select from the dropdown list.

When a Sample or Target name are edited, two entries are added to the Audit trail (one for
Delete, and another for Create).

Samples (13) Add

@— Color Mame = Dilution Factor  Sample Volume Spike Volume

@ [ | ENC 1.00 0.0 0.0
EPC 1.00 0.0 0.0

|| NTC 1.00 0.0 0.0

[ | PTC 1.00 0.0 0.0

[ | 51 1.00 0.0 0.0

[ | S1 EPC 1.00 0.0 0.0

51 Spk ... 1.00 0.0 0.0

51 Spk ... 1.00 0.0 0.0

B  51Spk.. 1.00 0.0 0.0

@_

(D) Add button
@ Checkbox—Select Targets and Samples to go in the selected well.
@ Textbox—Click the name to edit.
@ Scrollbar—Use to scroll to more properties.
® Use the plate setup toolbar (above the plate) to make edits to the plate.

- Click (@ View to show/hide the Sample Name, Sample Color, or Target from the
view.

* To add consecutive samples (with the same Target), select a well, then click-drag the
dark blue box to the right.

3. (Optional) Double-click a well to enter comments for the selected well.
4. Select ROX™ dye from the Passive Reference dropdown list (lower-left of screen).

5. Click Save to save the template.
This template can then be used to create experiments.

Create a ViralSEQ™ Lentivirus Proviral DNA Titer Kit experiment in AccuSEQ™
Real-Time PCR Software v3.2 or later

1. In the /A Home screen, click the Factory default/Admin Defined Template tab, then select a
ViralSEQ Lentivirus Proviral DNA Titer Kit template.

To navigate to through the available templates click the arrows to either side of the available
templates.
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Create New Experiment

— ®
ﬁ Factory default/Admin Defined . My Templates + Create New
Templates
O ViralSEQ MMV Dete... ViralSEQ Vesivirus ... MycoSEQ Plus Myc... ViralSEQ Quantitativ... Quantitative Kanam... @

To create an experiment from an existing ViralSEQ™ Lentivirus Proviral DNA Titer Kit experiment,
see AccuSEQ™ Real-Time PCR Software v3.2 User Guide (Pub. No. MAN0029199).

2. In the Experiment Properties pane of the Setup screen:
a. (Optional) Change the system-generated name of the experiment.

Note: Names must be unique. Deleted experiment names can not be reused.

b. (Optional) Enter the plate barcode in the Barcode field, then add comments in the Comments
field.

Note: Comments are not editable post analysis.

Default ViralSEQ™ Lentivirus Proviral DNA Titer Kit settings (cannot be changed)
¢ Experiment Type—Quantitation-Standard Curve
* Chemistry—TagMan™ Reagents
* Ramp Speed—Standard

c. Click Next.

Note: Experiment names cannot be changed after this step.

3. In the gPCR Method pane of the Setup screen, view the default volume and cycling conditions
(cannot be changed).

Note: This assay is run with a Standard ramp speed.
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Hold Stage PCR Stage
95°C 95°C
1.6 "C/S
10:00 00:15 .
1.6-2C/S
= = : 60 °C:
C/s o
01:00
-3 O
Step 1 Step 1 Step 2
40x

Figure 7 ViralSEQ™ Lentivirus Proviral DNA Titer Kit template default cycling conditions

4. Click Next.

5. In the Samples table of the Plate Setup pane, enter the sample name. Sample volume is not
needed. Click Add to add more samples if needed.

Note: The software calculates provirus copies per cell in the results if the number of cells
extracted is entered.

IMPORTANT! Do not change the Targets.

(1)—Samples (24) Add

Color Name =
1A
[ 1B

@ Samples table

(2) Add—adds more samples

Dilution

1.00

1.00

Sample Volume

0.00

For more information about plate setup, see “Assign plate and well attributes” on page 62.

66

Sample Volume —not applicable; leave as default (0).
Spike Volume —volume of DNA added to the PCR (set to 10).
Spike Standard Concentration—expected spike amount per reaction (for example,

10 copies).

Reference —the non-spiked sample; the mean quantity of reference is subtracted during %

recovery calculation.
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Spike Input—calculated (double check if correct).
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| |

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is
the expected copies spike per PCR reaction.

(Optional) Comments

Number of Cells Extracted —needed to calculate provirus copies per cell in the results.

Samples (24) Add

Spike Volume

Spike Standard Concentratiol B

O—p ¢

@—

@ Textbox—type in the value, or use the up and down arrows

0.00

0.00

0.00

0.00

0.00

0.00

0.00

@ Scroll bar—scroll to find the parameter to edit

@®—=

SC1-1E7cp W
A LTR3-D..."%
1.0000E+7
IPC "=
§C2-1E5cp W
B LTR3-D..."%
1.0000E+5
Bec ==
§C3-1E3cp W
[ LTR3-D..."%
1.0000E+3
PCc "=
SC4-100cp W
] LTR3-D..."%
100.0000
W ec ==
§C5-25cp M
E LTR3-D..."%
25,0000
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SCE-10cp W

F | ElluRso. =
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NTC
H | [{]urRs-p.m=
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Figure 8 ViralSEQ™ Lentivirus Proviral Titer Kit template default sample plate layout
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Table 19 Plate well descriptions

Name Description
SC1to SC6 Standard curve dilutions in triplicate
MT1 to MT3 18 samples in triplicate
NTC No template control in triplicate

6. (Optional) Double-click wells to add Comments. Comments can also be added post-analysis.

Comments

B Sampled B Samplein B

7. Click Next.
The Run screen is displayed.

8. Experiments are auto-saved in the software. To save, exit the experiment. The software prompts
you to save changes. Click Yes.

Note: Clicking B Save As creates a copy of the experiment.

9. (Optional) Click "= Print to print the plate layout for use in preparing the reactions.

10. Assemble the PCR reactions following the manufacturer's instructions for the reagents and
following the plate layout set up in the template.
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Set up, run, and analyze samples with AccuSEQ™ Software v3.1 or later on the QuantStudio™ 5 Instrument

Load the plate in the instrument

CAUTION! Use optical flat caps for tubes. Rounded caps can damage the heated cover.

Load the plate.
1. Touch ® to eject the instrument drawer.

2. Load the plate onto the plate adapter so that:
e Well A1 of the plate is in the top-left corner of the plate adapter.
¢ The barcode faces the front of the instrument.

A1
§
(VAN

IMPORTANT! The instrument should be used by trained operators who have been warned of the
moving parts hazard.

Note: Do not remove the black plate adapter before loading a plate or tube strips. If used, tube
strips can fit loosely in the adapter, but the heated cover applies the appropriate pressure to seat
the tube strips securely in the adapter.

CAUTION! PHYSICAL INJURY HAZARD. During instrument operation, the plate temperature
can reach 100°C. Allow it to cool to room temperature before handling.

3. Touch @ to close the instrument drawer.
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Set up, run, and analyze samples with AccuSEQ™ Software v3.1 or later on the QuantStudio™ 5 Instrument

Start the run (QuantStudio™ 5 Real-Time PCR Instrument)

Ensure that the plate is loaded in the QuantStudio™ 5 Real-Time PCR Instrument.

Start the run in the AccuSEQ™ Software v3.1 or later.

Option Description

If the experiment is open Click Start Run.

If the experiment is closed a. Open the experiment.

b. Click the Run tab.
c. Click Start Run.

Run Control

Ampatication Piot ?

wens: [l 27 [[2 815 [ 6o @mpty

@ Run tab
Start Run button

A message stating Run has been started successfully is displayed when the run has started.
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Set up, run, and analyze samples with AccuSEQ™ Software v3.1 or later on the QuantStudio™ 5 Instrument

Monitor the run

During the instrument run, you can monitor the run from the following places:

¢ On the instrument touchscreen.
¢ In the Monitor the Run pane of the AccuSEQ™ Software 4 (Home) screen.

Monitor The Run

Q- PA-QS5-03
(@ gm— Running

(© - Calibrated

2020-06-01_8926

@ Instrument name
Instrument status (Ready, Running, Offline)
Calibration status
— Calibrated —All required calibrations are "Current". Required calibrations include: Background,
ROI/Uniformity, and Dyes.
— Not calibrated —None of the required calibrations are complete.
— Requires calibration—One or more dyes are not calibrated.
@ Time lapsed (if a run is in progress)
Total run time
Experiment name
¢ In the Open Existing Experiments pane of the AccuSEQ™ Software A (Home) screen. The
experiment being run is the first experiment listed. Status is Run.

@

Y A

Note: You cannot start another run while the instrument status is Running.
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When the run is complete, the status changes to Analysis and the status bar displays as complete.

@— Open Existing Experiments

2020-06-04_2696

@— Run

2020-06-04_8175

Setup

@ Open Existing Experiments pane
Experiment status

¢ In the Run tab of the AccuSEQ™ Real-Time PCR Software.
You can perform the following actions.
— Select wells in the plate layout to highlight respective curves in the plot.
— Hover over curves in the plot for well information.
— (Optional) Change what is displayed in the table wells, by selecting Sample Name, Sample
Color, or Target in the View dropdown list.

On run completion, the Post Run Summary displays the run length, user and instrument information,
and a list of any errors that occurred.

When the run is complete, unload the plate from the instrument.
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Review the results

Review the results

After the gPCR run is finished, use the following general procedure to analyze the results.
For more detailed instructions see the AccuSEQ™ Real-Time PCR Software v3.2 User Guide
(Pub. No. MAN0029199).

1. In the AccuSEQ™ Real-Time PCR Software, open the experiment, then navigate to the Result tab.

Setup Run Result Report Audit & E-Sign £# Analysis Settings  [) Save As [ Save As Template  [» Export Experiment

Experiment Name : SG11_SC_QS5_instr3_Day2_OP1 E-Sign Status : Unsigned Assay Name : SG11_SC_QS5_instr3_Day2_OP1

Result Summar y Result Analysis
Plots & Summan y Results
,«w\iuu;u HL?L ent| Rawdata | Standam Cuve | OC Semmary < | sample ¥ Selectitem ¥ || Sselectitem v 2 (o])=]e=
Vo )aa]#][® ] - (= ][=] :

Amplification Plot

ARn

. w
L] i 3. @wa L CEYJN‘ N
NTC WSCt WSC2 MSC3 MSC4 MSCs MSC6 a2, @0, @

welis: [@21 [§]3 [B]15 [] 75 Empty) 0%

@ Result screen

(@ Analysis Settings

@ Plot horizontal scrollbar
(@ Analyze button

2. In the Result Analysis tab, select individual targets, then review the Amplification Curve plots for
amplification profiles in the controls, samples, and the standard curve. Ensure that threshold is set
to 0.200 with an automatic baseline.

Note: If any settings are changed, click the Analyze button to apply the new settings to the
results. Target names and Sample names (under the Setup tab) can also be changed after the run
is completed.

3. In the Result Analysis tab, review the QC Summary for any flags in wells.
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K

4. In the Result Analysis tab, review the Standard Curve plot. Verify the values for the Slope,
Y-intercept, R2, and Efficiency are within acceptable limits.

Plots & Summary

AHI[:][I“(;(‘.IIOH !\Wullmnl)mpormm R:wla Data Standard Curve Qc 5;]|m:uy

3 \:H Q ‘ Q ‘ x ‘ a) H Targets ~ & H » ‘ Linear~ None~

Standard Curve Plot

36
34
32
30
28
26

6 24
22
20
18
16
14
12
10
84 s e (S .,

Te+1 1e+2 1e+3 Te+4 1e+5 Te+6 1e+7 Te+s Te+9
Quantity
Target: DNA, Slope: -3.3251, R"2: 0.9990, Y-Intercept: 38.8013, Efficiency: 99.87 StdError :0.0250

M Standard M Unknown

(1) Slope, R, and Efficiency values

Note: The Standard Curve efficiency should be between 90-110% and the R2>0.99. If these
criteria are not met, up to two points, not in the same ftriplicate, can be removed from the standard
curve data, and the analysis repeated.

5. In Table View, ensure that C; values are within the standard curve range.

* Samples with C; values that exceed the upper limit of quantitation (107 copies) of the standard
curve should be diluted and re-run.

¢ Samples with C; values that exceed the lower limit of detection (LoD of 10 copies) and IPC
shows no signs of PCR inhibition, suggests the absence of provirus.

6. (Optional) Outliers can be excluded from the results. To exclude, select the well, then click
Omit/Include, then reanalyze by clicking Analyze.

7. (Optional) Select File » Print Report to generate a hard copy of the experiment, or click Print
Preview to view and save the report as a PDF or HTML file.

8. Export the results.
a. Navigate to the Report screen.

b. Check all boxes under Contents.

c. Select Export Data in One File.
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Review the results

d. Select the XLS format, then click Export.

Calculate the infectious titer

Note: After analysis, AccuSEQ™ Software v3.2 or later provides provirus copies per cell in the table

view of the Results screen. Use of the Proviral Titer Calculation Tool is needed to calculate the
infectious titer.

1. Download the Proviral Titer Calculation Tool.
a. Go to thermofisher.com.

b. Search for the ViralSEQ™ Lentivirus Proviral DNA Titer Kit.
c. Download the tool from the Documents section.

2. Open the tool, then follow the instructions in the tool to calculate the titer.

Analyze the data without AccuSEQ™ Real-Time PCR Software

1. Set the threshold to 0.2 and use automatic baseline.

2. Export the C; values to a Microsoft™ Excel™ spreadsheet.

3. For the standard curve, plot logg of the standard quantity versus the mean C;.

4. Determine the equation of the standard curves by adding a trendline and displaying the equation.

5. Determine the quantity of the unknown samples using the C; values and the equation generated
from the trendline.
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Calculate provirus copies and lentivirus titers from gPCR data

Each provirus has 2 copies of the assay target (LTR).

1. To determine the number of provirus copies in the extracted sample, the copy numbers obtained
from the gPCR must be multiplied by 0.5 and then by the dilution factor of the sample during
extraction. The concentration of provirus per cell can be calculated based on the number of cells
used in the extraction.

gPCR copies x sample dilution factor x 0.5
Number of harvested cells used for extraction

Provirus copies per cell =

For help in determining the gPCR copy numbers, see the QuantStudio™ Design and Analysis
Desktop Software User Guide (Pub. No. MAN0O10408).

For example, if the following parameters were used,

* 10,000 cells were extracted with the KingFisher™ Flex Purification System with 96 Deep-Well
Head and eluted in 200 pL.

* 5 L of this eluate (40x dilution) was used for the gPCR reaction.
then, the calculation would be:

Provi , Il = gPCR copies x 40 x 0.5
rovirus copies per cell = 10,000

Note: The number of cells extracted can be determined by the counting of cells or nucleic acid
quantity equivalence (1 cell = 6.6 pg for diploid cells). Users should establish the nucleic acid
quantity equivalence for cells that are non-diploid.

2. To estimate the infectious viral titer (or transduction unit TU/mL), use the volume of lentivirus (mL)
that was used to infect the cells seeded for lentivirus transduction and the number of cells seeded
for transduction [No. of cells (Day 1)].

Provirus copies per cell x No. of cells (Day 1)
Volume of lentivirus (mL)

Infectious viral titer per mL =
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PrepSEQ™ sample preparation

Troubleshooting

Observation

Possible cause

Recommended action

Poor extraction efficiency (low
yields)

Overdrying the sample.

Start the 5 minute timer before removing ~300
pL from the first 6-8 samples. Then continue
removing wash buffer from the remaining
samples.

Magnetic Particles are difficult
to resuspend during the
elution.

Incubate the pellets at 70°C for >7 minutes.
Vigorously vortex the tubes three times during
incubation to help resuspension. Do not
overdry. If necessary, repeat the incubation
and vortexing steps.

Formation of precipitate in
Magnetic Particles.

Incubate the Magnetic Particle suspension at
37°C with intermittent vortexing at 900 rpm
until the particles are completely suspended.

PK Buffer was used instead of
PK Buffer Il.

Use PK Buffer Il.

Particles no longer produce
consistent results (fine brown
sandy particles and brown
color are observed in the
supernatant)

Samples have low pH.

Measure the pH of the sample and adjust the
pH to between 6 and 8 using NaOH or HCI as
needed.

Magnetic Particles were stored
at —20°C.

Order new materials and store them at room
temperature.

ViralSEQ™ assays

Observation

Possible cause

Recommended action

A Rn and Ct values are
inconsistent with replicates

Evaporation of reaction mixture
from some wells occurred
because the optical adhesive
cover was not correctly sealed
to the reaction plate or due to
over-drying the eluates in the
PrepSEQ™ workflow.

1. Select the Component tab. Confirm that
affected wells generated significantly less
fluorescence than unaffected replicates.

2. Check the amount of solution in each
well of the reaction plate. Confirm
that the wells affected by evaporation
contained less solution than unaffected
wells, and corresponded with the
inconsistent results.

3. For subsequent runs, ensure that the
optical adhesive cover is correctly sealed
to the reaction plate.

ViralSEQ™ Lentivirus Titer Kits User Guide

77



Appendix A Troubleshooting

ViralSEQ™ assays

Observation

Possible cause

Recommended action

A Rn and Ct values are
inconsistent with replicates
(continued)

Incorrect volume of PCR
reaction mix was added to
some reactions.

1. Select the Component tab. Confirm that
affected wells generated significantly less
fluorescence than unaffected replicates.

2. Select the Spectra tab. Confirm that
the wells with the incorrect volume of
PCR reaction mix generated significantly
different amounts of fluorescence than
the unaffected wells.

3. For subsequent runs, ensure the correct
volume of PCR reaction mix.

Jagged amplification plots

Weak lamp or incorrect
replacement.

Replace the lamp or make sure that the
existing replacement is correct.

No defined amplification plots

An incorrect detector was
selected on the amplification
plot.

or

An incorrect detector was
applied to the reactions when
setting up the plate document.

1. Confirm that the correct detector was
selected on the amplification plot.

2. If the correct detector was not selected,
then in the plate document, double-click
a well to view the Well Inspector, verify
that the detector settings are correct, and
reanalyze.

Slope for the standard curve is
outside the typical range, or R?
value is significantly less than
0.99.

When applying detectors for
standards, the Task and
Quantity were applied to the
wrong detector.

or

The incorrect Quantity was
entered.

or
Adjust baseline settings.
or

Poor standard curve
preparation technique (forgot
to mix, inaccurate pipetting).

1. In the SDS software, from the plate
document, double-click a well containing
a DNA standard to view the Well
Inspector.

2. Ensure that the correct Task and Quantity
are applied to the correct detector, then
reanalyze.

3. Compare std curve statistics using
autobaseline or manual baseline. The
upper limit of the manual baseline setting
must be 2 cycles before uptick in
amplification. Verify in Rn vs C; linear
view.

4. Increase final standard volumes (SD1 to
SD6) up to 500 pL if required. Larger
volumes will have less inaccuracies when

pipetting.

No target-specific signal

(FAM dye) is detected in

PCR positive control and/or
extraction positive control wells

FAM™ dye detector not
selected.

Make sure the FAM™ dye detector is selected
in the analysis software. Repeat the analysis
with the FAM™ dye detector selected.

IPC signal is low

Inhibition of PCR or insufficient
amount of assay mix added.

Repeat the sample preparation, then repeat
the assay.

If PCR inhibition continues, contact your FAS,
or dilute the sample (for example, 1:5 or 1:10)
to dilute inhibitors.
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ViralSEQ™ assays

Observation

Possible cause

Recommended action

No IPC signal is detected,
but target-specific signal is
detected

High copy number of

target cDNA/DNA resulting in
preferential amplification of the
target-specific cONA/DNA.

Dilute sample (to within standard curve range)
and repeat the assay.

Abnormal ARn values or
negative ARn values

Incorrect passive reference
was selected when setting up
the plate document.

1. From the plate document, double-click a
well to view the Well Inspector.

2. Ensure that ROX™ dye was selected as
the Passive Reference.

No IPC signal is detected

The VIC™ dye detector was not
selected.

Make sure the correct detector is selected in
the analysis software. Repeat the analysis with
the correct detector selected.

Amplification plot crosses the
threshold but no target-specific
signal is amplified

Probe hydrolysis or non-
optimal baseline setting.

View amplification plots for the affected wells
using Rn vs. C; to confirm no up-tick in
amplification.

Change baseline settings. Check manual or
autobaseline.

Contact Technical Support.

No dye signal in test sample
well

Error in preparation.

Repeat the sample preparation and perform
a new PCR reaction, using freshly prepared
sample and reagents.

NTC signals are < SD6 (LOD)

Contamination of master mix,
assay mix, pipettes, or work
area from improper handling of
samples or control template.

Decontaminate the work area and use clean,
dedicated pipettes when preparing reaction
mixes. Where possible, carry out experiment
in a biosafety cabinet or on dedicated work
benches.

Multiple bands (3 or more)
observed when PCR product is
run on an agarose gel.

Secondary or nonspecific PCR
products are produced in later
cycles of PCR.

The probe does not bind to the nonspecific
PCR products and thus does not affect the
accuracy of the results. The user does not
need to troubleshoot.
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Use the ViralSEQ™ Lentivirus
Physical Titer Kit with the 7500

Fast Real-Time PCR Instrument and
AccuSEQ™ software v2.x

Required materials not supplied ... ... .. i 80
Create a ViralSEQ™ Lentivirus Physical Titer Kit experiment in AccuSEQ™ Software v2.0

o 2 81
Create a ViralSEQ Lentivirus Physical Titer Kit experiment in AccuSEQ™ Software v2.2

o = = 84
Analyze the resUS . .. ... 87
Calculate lentivirus titers from qPCR data ........ .. . 88

Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Iltem Source

Instrument

7500 Fast Real-Time PCR System with AccuSEQ™ software v2.x Contact your local sales
representative

Generic consumables

Disposable gloves MLS
Aerosol-resistant pipette tips MLS
Pipettors: MLS

* Positive-displacement
* Air-displacement

* Multichannel

Consumables for the 7500 Fast Real-Time PCR System

MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode, 0.1 mL, 20 4346906
plates; for use with 7500 Fast Real-Time PCR System
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Appendix B Use the ViralSEQ™ Lentivirus Physical Titer Kit with the 7500 Fast Real-Time PCR Instrument and

AccuSEQ™ software v2.x

Create a ViralSEQ™ Lentivirus Physical Titer Kit experiment in AccuSEQ™ Software v2.0 or v2.1

(continued)
ltem Source

MicroAmp™ Optical 96-Well Reaction Plate with Barcode & Optical Adhesive 4314320
Films, 100 plates with covers

MicroAmp™ Optical 8-Cap Strips, 300 strips 4323032
MicroAmp™ Optical Adhesive Film Kit, 20 covers, 1 applicator, 1 optical cover 4313663
compression pad

MicroAmp™ Optical Adhesive Film 4360954

Create a ViralSEQ™ Lentivirus Physical Titer Kit experiment
in AccuSEQ™ Software v2.0 or v2.1

Note: AccuSEQ™ Software v2.2 or later has a factory default SEQ Experiment for the Lentivirus
Physical Titer Kit. For information about the factory default template, see “Create a ViralSEQ Lentivirus
Physical Titer Kit experiment in AccuSEQ™ Software v2.2 or later” on page 84.

Use this workflow for the Lentivirus Physical Titer Kit in AccuSEQ™ Software v2.0 or v2.1.

Plate document: settings

If you have run the assay frequently, you can use the table below to enter settings in Plate Document
fields. If you are a new user, follow the detailed instructions in the following sections.

Summary of settings for the Plate Document

In this field...

Use these settings

Detector Lentivirus

FAM™ dye (Select NFQ_MGB dye for quencher)

IPC VIC™ dye (Select NFQ_MGB dye for quencher)
Passive reference ROX™
RT-PCR Ramp rate 100%!1"
RT Temp: 45°C
Time: 30:00
Hold Temp: 95°C
Time: 10:00
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Create a ViralSEQ™ Lentivirus Physical Titer Kit experiment in AccuSEQ™ Software v2.0 or v2.1

(continued)
Summary of settings for the Plate Document
In this field... Use these settings
RT-PCR Cycling (Standard Mode) Cycles: 40

Temp: 95°C Time: 0:15
Temp: 60°C Time: 0:45

Analysis Lentivirus Automatic Baseline
Threshold: 0.2

' 1.6°C/second for other systems.

Create a plate document in AccuSEQ™ Software v2.0 or 2.1
1. In the home screen, select Create Custom Experiment.
2. In the Experiment name field, enter a unique name for the experiment.

3. Specify experiment information.
a. Select experiment type Quantitation - Standard Curve.

b. Select reagents TagMan™ Reagents.
c. Select ramp speed Standard.
4. In the Plate Setup screen, select the Define Targets and Samples tab.

5. Specify target information.
a. Click Add New Target.

b. Enter a host cell name in the target name field.
c. Select reporter FAM™ dye and quencher NFQ_MGB dye.
d. Select a color for this target.

6. Specify IPC target information.
. Click Add New Target.

[V

b. Enter IPC in the target name field.
c. Select reporter VIC™ dye and quencher NFQ_MGB dye.
d. Select a color for this target.

7. Define new samples.
a. Click Add New Sample.
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Create a ViralSEQ™ Lentivirus Physical Titer Kit experiment in AccuSEQ™ Software v2.0 or v2.1

b. In Sample Name, add the names of the samples you want to define.
c. Click Next, or select the Assign Targets and Samples tab.

8. In the Assign Targets and Samples tab, define new targets.

a. Follow the instructions in the top of the tab to set up the standards, unknowns, and negative
controls.

b. Click Define and Set Up Standards to open the Define and Set Up Standards dialog box to
enter the appropriate settings and define the standard curve. When defined, click Apply and
Close. The new standard curve is applied to the plate layout screen.

9. Assign the IPC to the standard curve wells.

10. In the Run Method screen, in the Graphical View tab.
a. In Reaction Volume Per Well, enter 25 pL

11. Click the Analysis button in the left panel. In the Analysis Settings window on the right, set the
default settings.

a. On the Ct Settings tab, click Edit Default Settings. Then set Threshold to 0.2, set to
Automatic Baseline, and then click Save Changes.

b. Select (highlight) both targets.
c. In the right-hand window, select Use Default Settings.
d. Click Apply Analysis Settings.

12. Select File » Save as, confirm that the file is named LV TiterTemplate or similar, then select Save
as a template file in the drop-down list and close the template plate document.

Note: You can reuse the plate template document to run an assay by opening the template file
and choosing Save As to save the file with the experiment name.

Run the plate in AccuSEQ™ Software v2.0 and v2.1
1. In the toolbar, select File » Open, navigate to the LV Titer Template file, then click Open.
2. In the Experiment Name field, enter the appropriate experiment name, then click Finish.

3. Make any necessary changes to the test sample labels.
¢ Sample Volume —not applicable; leave as default (0).
* Spike Volume—volume of DNA added to the PCR (set to 3).

* Spike Standard Concentration—expected spike amount per reaction (for example, 5,000
copies).

* Reference—the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.
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* Spike Input—automatically calculated (double check if correct).

Note: If incorrect, be sure Spike Volume is set to 10 and Spike Standard Concentration is
the expected copies per PCR reaction.

Select Save As to save the new experiment as an EDS experiment file with the same name as
entered in the Experiment Name field.

Load the plate into the instrument.
Click Start Run.

Select a run screen (Amplification plot, Temperature plot, or Run method) to monitor the
progress of the run.

Create a ViralSEQ Lentivirus Physical Titer Kit experiment in
AccuSEQ™ Software v2.2 or later

Note: The ViralSEQ Lentivirus Physical Titer Kit SEQ experiment is available with AccuSEQ™
Software v2.2 or later.

1.

2.

84

Click Create SEQ Experiment in the home screen.

Select ViralSEQ Lentivirus Physical Titer Kit from the assay list, then click Next .
The Plate Setup screen opens.

In the Experiment Menu navigation bar, click Experiment Properties.

Enter the experiment name.

Note: The experiment name can be up to 100 letters and numbers. Spaces are not allowed.

(Optional) Enter a plate barcode and comments.
In the Experiment Menu navigation bar, click Plate Setup.
In the Define Samples pane of the Define Targets and Samples tab of the Plate Setup pane,

enter the sample name, then enter the sample dilution. Click Add New Sample to add more
samples if needed.

IMPORTANT! Do not change the Targets.
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Define Samples. Sample Name defines replicate group

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Sample Name Dilution Factor | Sample Volume  Spike Volume  Spike £
§C5 1.0 0.0 0.0

SC6 1.0 0.0 0.0

NTC 1.0 0.0 0.0

Matrix D1_EW1 0.0 0.0

Matrix D2_EW1 1.0 0.0 0.0

Matrix D3_EW1 1.0 0.0 0.0

For information about adding and defining samples, see AccuSEQ™ Real-Time PCR Software v2.2
User Guide (Pub. No. MAN0029201).

8. In the Define Samples pane in the Define Targets and Samples tab, scroll to the right, then enter
the sample volume and spike information.

Define Samples. Sample Name defines replicate group

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Spike Volume Spike Standard Concentration  Reference Spike Input  Color  Number

0.0 [No Refer.. -~ 0.0 v
0.0 0.0 [No Refer... ~ 0.04 v
0.0 0.0 [No Refer... ~ 0.0} v
0.0 0.0 [No Refer... 0.0 v
0.0 0.0 [No Refer... ~ 0.0§ v
0.0 0.0 |No Refer... 0.0 v

¢ Sample Volume —add sample volume to calculate viral particles per mL in the results.
* Spike Volume—volume of DNA added to the PCR (set to 10).

* Spike Standard Concentration—expected spike amount per reaction (for example,
10 copies).

* Reference—the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.
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* Spike Input—calculated (double check if correct).

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is
the expected copies spike per PCR reaction.

* Protein Concentration—Drug substance protein concentration (if total DNA in
copies RNA/mg protein is needed).

® (Optional) Comments

Note: The software calculates viral particles per mL if the sample volume was entered.

9. Click the Assign Targets and Samples tab.
The default plate layout is shown.
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Table 20 Plate well descriptions
Name Description

Lenti-1 to Lenti-4 4 samples in triplicate

L1-RNA to L6-RNA
NTC-RDB

Standard curve dilutions in triplicate

No template control in triplicate

10. (Optional) Edit the plate.

To change the plate layout display, see AccuSEQ™ Real-Time PCR Software v2.2 User Guide (Pub.
No. MAN0029201).

a. Assign the targets to wells in the plate layout.
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11.

12.

13.

14.

15.

16.

17.

18.

AccuSEQ™ software v2.x
Analyze the results

b. Assign samples to wells in the plate layout.
Confirm that ROX™ dye is selected as the passive reference.

(Optional) Save the plate layout as an image.
a. Right-click the plate layout.

b. Select Save As.

c. Specify a file name and location for the JPEG file, then click Save.

Note: Electronic signature information is not included in an image file. Use Print Report to
include Electronic signature information with the plate layout.

(Optional) Print the plate layout
a. Right-click the plate layout.

b. Click Print Preview or Print.
In the Experiment Menu navigation bar, click Run Method.

In the Run Method screen, view the default volume and cycling conditions.

IMPORTANT! Do not modify the run method for factory default SEQ experiments.

In the Experiment Menu navigation bar, click Reaction Setup.

In the Reaction Setup screen, complete the reaction setup. For more information about the
reaction setup, see AccuSEQ™ Real-Time PCR Software v2.2 User Guide (Pub. No. MAN0029201).

Assemble the PCR reactions following the instructions of the manufacturer for the reagents and
following the plate layout set up in the template.

Analyze the results

After the gPCR run is finished, use the following general procedure to analyze the results:

1.

2.

ViralSEQ™ Lentivirus Titer Kits User Guide

In the toolbar, select Analysis » Analysis Settings.
Click (Analyze).
Select Analysis » QC Summary in the left panel of the screen. Review the flag summary.

In the left panel, select Analysis » Standard Curve. Verify the values for the Slope, Y-Intercept, R2,
and Efficiency.

Select File » Export. In the Export Data menu, select file type *.xlIs. Click Start Export.
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Calculate lentivirus titers from gPCR data

6. Calculate titers using the Physical Titer Calculation Tool.

IMPORTANT! In AccuSEQ™ software v2.x, Quantity values above 2.1474836 x 107 copies per
reaction do not display correctly in the software, which also results in incorrect display of the Mean
Quantity and Quantity Standard Deviation. Disregard values in the table view of the software
with a Quantity of 2.1474836 x 107, and instead use data in the Excel™ spreadsheet exported from
the software. This error does not impact plotting of data on the standard curve or in the Excel™
report.

Calculate lentivirus titers from qPCR data

88

To determine the number of lentivirus RNA copies per mL in the original sample, the copy numbers
obtained from the gPCR must be multiplied by the dilution factor of the sample during extraction and
DNase | treatment. Since there are 2 copies of RNA/target per lentivirus particle, the number of viral
particles per mL (VP/mL) is 0.5x the number of lentivirus RNA copies.

gPCR copies x sample dilution factor x 0.5
Volume of sample used (mL)

Viral particles per mL =

For help in determining the gPCR copy numbers, see the QuantStudio™ Design and Analysis Desktop
Software User Guide (Pub. No. MANOO010408).

For example, if the following parameters were used,

¢ 10 L of lentivirus culture was extracted with the KingFisher™ Flex Purification System with 96
Deep-Well Head and eluted in 200 pL

e 10 pL of this eluate (20x dilution) was treated with DNase |, RNase-free (1 U/pL) in a total volume of
20 pL.

e 5 L of the DNase-treated sample (4x dilution) was used for the gPCR reaction.

Use 10 pL Use 5 pL
B (1:20 dilution) (1:4 dilution)
Lentivirus sample Sample Extraction DNasel Treat RT-gPCR
10 pL Elute: 200 pL Total: 20 pL reaction Total: 25 pL reaction

then, the calculation would be:

gPCR copies x (20x4) x 0.5
0.01 (mL)

Viral particles per mL =

Note: gPCR can only determine the number of physical particles in a virus culture. To determine the
numbers of infectious units, cell-based transduction experiments must be carried out. The titers of
physical particles are often higher than infectious titers by 10-1000 fold, depending on the purity of the
lentivirus preparation and the levels of infectious particles within the culture.
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Required materials not supplied

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Iltem Source

Instrument

7500 Fast Real-Time PCR System with AccuSEQ™ software v2.x Contact your local sales
representative

Generic consumables

Disposable gloves MLS
Aerosol-resistant pipette tips MLS
Pipettors: MLS

* Positive-displacement
* Air-displacement

* Multichannel

Consumables for the 7500 Fast Real-Time PCR System

MicroAmp™ Fast Optical 96-Well Reaction Plate with Barcode, 0.1 mL, 20 4346906
plates; for use with 7500 Fast Real-Time PCR System
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Create a ViralSEQ™ Lentivirus Proviral DNA Titer Kit experiment in AccuSEQ™ Software v2.0 or v2.1

(continued)
ltem Source

MicroAmp™ Optical 96-Well Reaction Plate with Barcode & Optical Adhesive 4314320
Films, 100 plates with covers

MicroAmp™ Optical 8-Cap Strips, 300 strips 4323032
MicroAmp™ Optical Adhesive Film Kit, 20 covers, 1 applicator, 1 optical cover 4313663
compression pad

MicroAmp™ Optical Adhesive Film 4360954

Create a ViralSEQ™ Lentivirus Proviral DNA Titer Kit
experiment in AccuSEQ™ Software v2.0 or v2.1

Note: AccuSEQ™ Software v2.2 or later has a factory default SEQ Experiment for the Lentivirus
Proviral DNA Titer Kit. For information about the factory default template, see “Create a ViralSEQ
Lentivirus Proviral DNA Titer Kit experiment in AccuSEQ™ Software v2.2 or later” on page 93.

Use this workflow for the Lentivirus Proviral DNA Titer Kit in AccuSEQ™ Software v2.0 or v2.1.

Plate document: settings

If you have run the assay frequently, you can use the table below to enter settings in Plate Document
fields. If you are a new user, follow the detailed instructions in the following sections.

Summary of settings for the Plate Document

In this field... Use these settings
Detector Provirus FAM™ dye (Select NFQ_MGB dye for quencher)
IPC VIC™ dye (Select NFQ_MGB dye for quencher)
Passive reference ROX™
gPCR Ramp rate 100%!1"
Hold Temp: 95°C
Time: 10:00
Cycling (Standard Mode) Cycles: 40
Temp: 95°C Time: 0:15
Temp: 60°C Time: 1:00
Analysis Provirus Automatic Baseline
Threshold: 0.2

' 1.6°C/second for other systems.
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Create a ViralSEQ™ Lentivirus Proviral DNA Titer Kit experiment in AccuSEQ™ Software v2.0 or v2.1

Create a plate document in AccuSEQ™ Software v2.0 and v2.1
1. In the home screen, select Create Custom Experiment.
2. In the Experiment name field, enter a unique name for the experiment.

3. Specify experiment information.
a. Select experiment type Quantitation - Standard Curve.

b. Select reagents TagMan™ Reagents.
c. Select ramp speed Standard.
4. In the Plate Setup screen, select the Define Targets and Samples tab.

5. Specify target information.
. Click Add New Target.

[V

b. Enter a host cell name in the target name field.
c. Select reporter FAM™ dye and quencher NFQ_MGB dye.
d. Select a color for this target.

6. Specify IPC target information.
a. Click Add New Target.

[op

. Enter IPC in the target name field.
c. Select reporter VIC™ dye and quencher NFQ_MGB dye.
d. Select a color for this target.

7. Define new samples.
a. Click Add New Sample.

b. In Sample Name, add the names of the samples you want to define.
c. Click Next, or select the Assign Targets and Samples tab.

8. In the Assign Targets and Samples tab, define new targets.

a. Follow the instructions in the top of the tab to set up the standards, unknowns, and negative
controls.

b. Click Define and Set Up Standards to open the Define and Set Up Standards dialog box to
enter the appropriate settings and define the standard curve. When defined, click Apply and
Close. The new standard curve is applied to the plate layout screen.

9. Assign the IPC to the standard curve wells.
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Create a ViralSEQ™ Lentivirus Proviral DNA Titer Kit experiment in AccuSEQ™ Software v2.0 or v2.1

10. In the Run Method screen, in the Graphical View tab.
a. In Reaction Volume Per Well, enter 30 pL

11. Click the Analysis button in the left panel. In the Analysis Settings window on the right, set the
default settings.

a. On the Ct Settings tab, click Edit Default Settings. Then set Threshold to 0.2, set to
Automatic Baseline, and then click Save Changes.

b. Select (highlight) both targets.
c. In the right-hand window, select Use Default Settings.
d. Click Apply Analysis Settings.

12. Select File » Save as, confirm that the file is named LV Proviral Template or similar, then select
Save as a template file in the drop-down list and close the template plate document.

Note: You can reuse the plate template document to run an assay by opening the template file
and choosing Save As to save the file with the experiment name.

Run the plate in AccuSEQ™ Software v2.0 and v2.1
1. In the toolbar, select File » Open, navigate to the LV Proviral Template file, then click Open.
2. In the Experiment Name field, enter the appropriate experiment name, then click Finish.

3. Make any necessary changes to the test sample labels.
* Sample Volume—not applicable; leave as default (0).
¢ Spike Volume—volume of DNA added to the PCR.

* Spike Standard Concentration—expected spike amount per reaction (for example, 5,000
copies).

* Reference—the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

* Spike Input—automatically calculated (double check if correct).

Note: If incorrect, be sure Spike Volume is set correctly and Spike Standard Concentration
is the expected copies per PCR reaction.

P

Select Save As to save the new experiment as an EDS experiment file with the same name as
entered in the Experiment Name field.

[

. Load the plate into the instrument.

o

Click Start Run.

7. Select a run screen (Amplification plot, Temperature plot, or Run method) to monitor the
progress of the run.
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Create a ViralSEQ Lentivirus Proviral DNA Titer Kit experiment in AccuSEQ™ Software v2.2 or later

Create a ViralSEQ Lentivirus Proviral DNA Titer Kit
experiment in AccuSEQ™ Software v2.2 or later

Note: The ViralSEQ Lentivirus Proviral DNA Titer Kit SEQ experiment is available with AccuSEQ™
Software v2.2 or later.

1. Click Create SEQ Experiment in the home screen.

2. Select ViralSEQ Lentivirus Proviral DNA Titer Kit from the assay list, then click Next .
The Plate Setup screen opens.

3. In the Experiment Menu navigation bar, click Experiment Properties.

4. Enter the experiment name.

Note: The experiment name can be up to 100 letters and numbers. Spaces are not allowed.

5. (Optional) Enter a plate barcode and comments.
6. In the Experiment Menu navigation bar, click Plate Setup.
7. In the Define Samples pane of the Define Targets and Samples tab of the Plate Setup pane,

enter the sample name, then enter the sample dilution. Sample volume is not needed. Click Add
New Sample to add more samples if needed.

IMPORTANT! Do not change the Targets.

Define Samples. Sample Name defines replicate group

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Sample Name Dilution Factor = Sample Volume @ Spike Volume | Spike £
SC5 1.0 0.0 0.0

SC6 1.0 0.0 0.0

NTC 1.0 0.0 0.0

Matrix D1_EW1 1.0} 0.0 0.0

Matrix D2_EW1 1.0 0.0 0.0

Matrix D3_EWA1 1.0 0.0 0.0

For information about adding and defining samples, see AccuSEQ™ Real-Time PCR Software v2.2
User Guide (Pub. No. MAN0029201).
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8. In the Define Samples pane in the Define Targets and Samples tab, scroll to the right, then enter
the spike information.

Define Samples. Sample Name defines replicate group

Add New Sample | Add Saved Sample | Save Sample | Delete Sample

Spike Volume Spike Standard Concentration  Reference Spike Input  Color  Number

0.0 [No Refer... 0.0

0.0 0.0 [No Refer... ~ 0.04 v
0.0 0.0 [No Refer... ~ 0.0} v
0.0 0.0 [No Refer... 0.0 v
0.0 0.0 [No Refer... ~ 0.0§ v
0.0 0.0 |No Refer... 0.0 v

¢ Sample Volume —not needed; leave as default (0).
* Spike Volume—volume of DNA added to the PCR (set to 10).

* Spike Standard Concentration—expected spike amount per reaction (for example,
10 copies).

* Reference—the non-spiked sample; the mean quantity of reference is subtracted during %
recovery calculation.

* Spike Input—calculated (double check if correct).

Note: If not correct, ensure Spike Volume is set to 10 and Spike Standard Concentration is
the expected copies spike per PCR reaction.

¢ (Optional) Comments
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Create a ViralSEQ Lentivirus Proviral DNA Titer Kit experiment in AccuSEQ™ Software v2.2 or later

* Number of Cells Extracted—needed to calculate provirus copies per cell in the results.

Define Samples. Sample Name defines replicate group

Add Saved Sample | Save Sample | Delete Sample

0.0 |[No Refer... ~ 0.0 v

ke Standard Concentration = Reference Spike Input  Color | Number of cells extracted

0.0 |No Refer... ~ 0.0 w

0.0

0.0 (No Refer... ~ 0.0 w

00

0.0 [No Refer... v 0.0 w

0.0

0.0 |No Refer... ~ 0.0 et

0.0

0.0 |No Refer... ~ 0.0 w

0.0

Note: The software calculates provirus copies per cell if the number of cell extracted was entered.

9. Click the Assign Targets and Samples tab.
The default plate layout is shown.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

Table 21 Plate well descriptions

Name Description
SC1to SC6 Standard curve dilutions in triplicate
MT1 to MT3 3 samples with 6 matrices
NTC No template control in triplicate

(Optional) Edit the plate.

To change the plate layout display, see AccuSEQ™ Real-Time PCR Software v2.2 User Guide (Pub.
No. MAN0029201).

a. Assign the targets to wells in the plate layout.
b. Assign samples to wells in the plate layout.
Confirm that ROX™ dye is selected as the passive reference.

(Optional) Save the plate layout as an image.
a. Right-click the plate layout.

b. Select Save As.

c. Specify a file name and location for the JPEG file, then click Save.

Note: Electronic signature information is not included in an image file. Use Print Report to
include Electronic signature information with the plate layout.

(Optional) Print the plate layout
a. Right-click the plate layout.

b. Click Print Preview or Print.
In the Experiment Menu navigation bar, click Run Method.

In the Run Method screen, view the default volume and cycling conditions.

IMPORTANT! Do not modify the run method for factory default SEQ experiments.

In the Experiment Menu navigation bar, click Reaction Setup.

In the Reaction Setup screen, complete the reaction setup. For more information about the
reaction setup, see AccuSEQ™ Real-Time PCR Software v2.2 User Guide (Pub. No. MAN0029201).

Assemble the PCR reactions following the instructions of the manufacturer for the reagents and
following the plate layout.
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Analyze the results

After the gPCR run is finished, use the following general procedure to analyze the results:

1. In the toolbar, select Analysis » Analysis Settings.
2. Click 25 (Analyze).
3. Select Analysis » QC Summary in the left panel of the screen. Review the flag summary.

4. In the left panel, select Analysis » Standard Curve. Verify the values for the Slope, Y-Intercept, R2,
and Efficiency.

5. Select File » Export. In the Export Data menu, select file type *.xls. Click Start Export.

6. Calculate titers using the Proviral Titer Calculation Tool.

Calculate provirus copies and lentivirus titers from qPCR
data

Each provirus has 2 copies of the assay target (LTR).

1. To determine the number of provirus copies in the extracted sample, the copy numbers obtained
from the gPCR must be multiplied by 0.5 and then by the dilution factor of the sample during
extraction. The concentration of provirus per cell can be calculated based on the number of cells
used in the extraction.

gPCR copies x sample dilution factor x 0.5
Number of harvested cells used for extraction

Provirus copies per cell =

For help in determining the gPCR copy numbers, see the QuantStudio™ Design and Analysis
Desktop Software User Guide (Pub. No. MANO010408).

For example, if the following parameters were used,

* 10,000 cells were extracted with the KingFisher™ Flex Purification System with 96 Deep-Well
Head and eluted in 200 pL.

* 5 L of this eluate (40x dilution) was used for the gPCR reaction.

then, the calculation would be:

gPCR copies x40 x 0.5
10,000

Provirus copies per cell =

Note: The number of cells extracted can be determined by the counting of cells or nucleic acid
quantity equivalence (1 cell = 6.6 pg for diploid cells). Users should establish the nucleic acid
quantity equivalence for cells that are non-diploid.
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2. To estimate the infectious viral titer (or transduction unit TU/mL), use the volume of lentivirus (mL)
that was used to infect the cells seeded for lentivirus transduction and the number of cells seeded
for transduction [No. of cells (Day 1)].

Provirus copies per cell x No. of cells (Day 1)
Volume of lentivirus (mL)

Infectious viral titer per mL =
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Good laboratory practices

Good laboratory practices for PCR and RT-PCR

* Wear clean gloves and a clean lab coat.

— Do not wear the same gloves and lab coat that you have previously used when handling
amplified products or preparing samples.

* Change gloves if you suspect that they are contaminated.

* Maintain separate areas and dedicated equipment and supplies for:
— Sample preparation and reaction setup.

— Amplification and analysis of products.
* Do not bring amplified products into the reaction setup area.
* Open and close all sample tubes carefully. Avoid splashing or spraying samples.
* Keep reactions and components capped as much as possible.
* Use a positive-displacement pipettor or aerosol-resistant barrier pipette tips.

¢ Clean lab benches and equipment periodically with 10% bleach solution or DNA decontamination
solution.

Good pipetting practices

* Use calibrated pipettes that are appropriate for volumes recommended by the manufacturer. Use
pipette tips compatible with the pipettes.

* Immerse the pipette tip 2-3 mm below the meniscus during aspiration. Avoid air aspiration or
pressing the tip on the container/tube bottom.

* Press and release the plunger at a consistent speed and pressure.

* Check the pipette tip before dispensing to ensure that there is appropriate volume drawn and that
there is no additional droplet on the outside of the tip.

¢ When dispensing, press and hold the plunger to the second stop until tip is removed from the
liquid. This prevents re-aspiration of the sample. Check the tip after dispensing to ensure that there
is no residual liquid left in the tip.
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Appendix D Good laboratory practices
Avoiding false positives due to cross-contamination

Avoiding false positives due to cross-contamination

To avoid false positives due to cross-contamination:

* Prepare and close all negative control and unknown sample tubes before pipetting the positive
control.

* Do not open tubes after amplification.

¢ Use different sets of pipettors when pipetting negative control, unknown, and positive control
samples.

Plate layout suggestions

* For each plate row, dispense in sequence from left to right the: negative controls, unknown
samples, and positive controls (at the end of the row or column).

* Place positive controls in one of the outer columns.

* If possible, separate all samples from each other by at least one well; if space is limiting, place at
least one well between unknown samples and controls.
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.
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Appendix E Safety
Chemical safety

Chemical safety

/W\. WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
&~ read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.
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Biological hazard safety

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
https://www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-
P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Document Publication number
ViralSEQ™ Lentivirus Physical Titer Kit Quick Reference MANO0026127
ViralSEQ™ Lentivirus Proviral Titer Kit Quick Reference MANO0026218
PrepSEQ™ Nucleic Acid Sample Preparation Kit User Guide MANO0026641
AccuSEQ™ Real-Time PCR Software v3.2 User Guide MANO0029199
AccuSEQ™ Real-Time PCR Software v2.2 User Guide MAN0029201
QuantStudio™ 3 and 5 Real-Time PCR Systems Installation, Use, and Maintenance MANOO010407
Guide
QuantStudio™ Design and Analysis Desktop Software User Guide MANO0O010408
Applied Biosystems™ 7300/7500/7500 Fast Real-Time PCR System Getting Started 4347825
Guide: Absolute Quantitation using Standard Curve

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
¢ Worldwide contact telephone numbers
* Product support information
- Product FAQs
- Software, patches, and updates
— Training for many applications and instruments
* Order and web support

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.
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Appendix F Documentation and support
Limited product warranty

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the
Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at

www.thermofisher.com/support.
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